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 ОБ ЭТОМ РУКОВОДСТВЕ ПОЛЬЗОВАТЕЛЯ 
Это руководство пользователя описывает PhotoScore - часть PhotoScore & NotateMe, которая позволяет 
сканировать партитуры и преобразовывать их в цифровую форму (для редактирования, воспроизведения, 
печати, и т.д.). 
Другая часть, названная NotateMe, позволяет создавать цифровую партитуру (любого размера в пределах от 
соло до оркестровой) путем записи на устройстве с сенсорным экраном со стилусом или пальцем. (Она может 
также использоваться с мышью, но это менее рекомендуется.) Она распознает широкий спектр стилей почерка и 
музыкальных символов, но также и позволяет перетащить на партитуру дополнительные символы. Лирика и 
символы аккордов также могут быть добавлены. Как только партитура была создана, она может быть передана 
PhotoScore так, чтобы среди других вещей она могла быть распечатана, экспортирована, или созданы партии 
из нее. NotateMe описан полностью в отдельном руководстве пользователя, которое может быть открыто из 
меню Справки. PhotoScore очень сложна со многими расширенными функциями. Прочитайте все это руководство 
пользователя, за исключением раздела Расширенные функции, прежде чем начнете работать. 
Если вы намереваетесь отсканировать относительно сложные партитуры, такие как музыка для оркестров / 
джаз-бэндов или многостраничные партитуры, мы настоятельно рекомендуем вам начать с более простой 
музыки, пока вы не приобретете опыт с PhotoScore, а затем ознакомитесь с разделом Расширенные функции. 
Существует две основных версии этого программного обеспечения: PhotoScore & NotateMe Ultimate 
(содержащая Полную PhotoScore) и PhotoScore & NotateMe Lite (содержащая Облегченную PhotoScore). Первая 
позволяет распечатывать и сохранять музыку во множестве форматов, а последняя имеет урезанную 
функциональность. Все они могут выполняться в операционных системах Mac OS X и Windows, однако в данном 
руководстве описана Windows-версия. Поскольку интерфейс варьируется немного между этими версиями, части 
этого руководства пользователя специфицированы для различных пользователей. Эти разделы выделены 
серым фоном, и тип пользователя, на которого они нацелены, напечатан наверху. Например, 'пользователи 
Windows' или ‘пользователи Sibelius’. 

 

УСТАНОВКА 

Требования 
Для использования PhotoScore & NotateMe вам будет нужно: 
Пользователи Windows  

 Рекомендуется IBM-совместимый ПК с процессором Pentium III (или эквивалентным процессором AMD) или 
более мощным. По меньшей мере 512 МБ RAM рекомендуются.  

 Microsoft Surface Pro с Surface Pen рекомендуется для NotateMe  

 Windows Vista/7/8/10  

 Ваш компьютер должен также иметь разумное количество свободного места на жестком диске - по крайней 
мере 40 МБ, и предпочтительно больше.  

 Замечание для пользователей Sibelius: Хотя PhotoScore & NotateMe будет работать с версией Sibelius 3.0 и 
выше, рекомендуется использовать Sibelius 5 или выше, поскольку там значительно улучшены 
импортирующие возможности для PhotoScore & NotateMe.  

 Сканер (вероятно, подключенный к вашему компьютеру через порт USB, Printer или SCSI), и установленное 
программное обеспечение драйвера TWAIN или WIA. 

 
На каком количестве компьютеров я могу установить PhotoScore & NotateMe? 
Если вы не обладаете многопользовательской корпоративной лицензией, вам разрешено использовать только 
одну копию PhotoScore & NotateMe на одном компьютере за один раз. Все копии последовательно 
пронумерованы; нелегальные копии могут быть легко прослежены до их первоначального владельца. 

 

 

 ВВЕДЕНИЕ 
PhotoScore является программой распознавания печатной и рукописной (Только Полная версия) музыки - 
музыкальный эквивалент программ оптического распознавания текстов OCR (напр., ABBYY FineReader). 
Сканирование текстов – задача сложная для компьютеров, лишь за последние несколько лет научились 
выполнять это с достаточной точностью. Сканирование музыки намного более трудно, чем сканирование текста, 



из-за более сложного диапазона включенных символов, из-за сложной двумерной 'грамматики' музыки, и потому 
что некоторые пометки, такие как вилки и фразовые метки, имеют переменную форму и размер. 
Сложность распознавания музыки или текста состоит в том, что при сканировании страницы компьютер «не 
понимает» ее. С точки зрения компьютера, отсканированная страница – всего лишь сетка из миллионов черных и 
белых точек, которые могут быть музыкой, текстом, фотографией или еще чем-то. 
Процесс же настоящего распознавания или интерпретации музыки, текста или изображения из сетки точек 
невероятно сложен и слабо понятен. Большая часть мозга человека, содержащая много миллионов связей, 
служит исключительно для решения проблемы «распознавания образов». 
Neuratron всегда раздвигал границы этой технологии с PhotoScore и путем объединения результатов 
распознавания двух независимо разработанных механизмов распознавания, точность PhotoScore выше намного 
больше, чем двукратно, по сравнению с каждым механизмом по отдельности! 

Подходящие оригиналы 
Программа PhotoScore разработана для чтения оригиналов, которые удовлетворяют следующим критериям: 

Умещается в размер вашего сканера (т.е. сама музыка обычно не больше, чем размер Letter/A4, хотя лист 
может быть и крупнее), 

Имеет размер нотоносца не менее 3 мм 

Все довольно ясно - например, линии нотоносца должны быть непрерывными и не прерываться и не быть 
покрытыми пятнами, головки половинных и целых нот, а также бемоли должны состоять из непрерывных 
окружностей, не прерываться и не быть заполненными, вязки у шестнадцатых и более коротких нот должны 
иметь достаточно белых промежутков, а объекты, которые должны располагаться отдельно (например, 
нотные головки и предшествующие им знаки альтерации) не должны перекрывать друг друга. 

Музыка, которая не подходит под эти условия, возможно и распознается, но точность при этом будет 
существенно ниже. 
В частности, не рекомендуется сканировать ксерокопии за исключением очень качественных, поскольку 
копирование обычно сильно ухудшает качество оригинала. Возможно, вам придется воспользоваться 
ксерокопией в том случае, когда оригинал больше, чем ваш сканер, но в таких случаях будьте готовы к снижению 
качества. 

Рукописная музыка 
Поддерживается широкий спектр стилей почерка, и без необходимости описать для PhotoScore стиль почерка, 
который вы сканируете. 
Нужно помнить, что распознавание рукописной музыки является невероятно трудной вещью для компьютера. 
Пожалуйста, прочитайте главу Чтение Рукописной Музыки, чтобы максимально использовать эту 
захватывающую новую технологию. 
Важно: Если бы вы захотели использовать PhotoScore & NotateMe для рукописного ввода музыки на устройстве 
с сенсорным экраном с помощью стилуса или пальца, обратитесь к руководству пользователя NotateMe, которое 
может быть открыто из меню Справки. 
Использование программы PhotoScore без сканера 

Помимо распознавания музыки, которую вы сами отсканировали своим сканером, программа может распознавать 
музыку и без применения сканера, либо открывая отдельные страницы, которые вы сохранили в файлах 
графических форматов, либо открывая PDF-файлы. 
Чтобы работать с графическими файлами, необходимо, чтобы каждая страница музыки хранилась на 
компьютере в отдельном файле в формате BMP или TIFF. 
Программа PhotoScore также может распознавать PDF-файлы. Распознавание PDF-файлов может быть 
полезным, если музыка, которую вы хотите сканировать, доступна на сайте в формате PDF, либо вы хотите 
преобразовать файл из другой музыкальной программы, выведя в ней PDF-файл и затем открыв его в программе 
PhotoScore. 
Прежде, чем вы решитесь переносить музыку из другой программы с помощью PDF-файла, проверьте, не 
поддерживается ли в той программе экспорт в формате файлов, который программа Sibelius может читать 
непосредственно, например, формат MusicXML, это было бы гораздо удобней, чем применять PDF-файлы. 

Музыка авторского права 
Вы должны знать, что если вы сканируете чужую музыку без разрешения, то вы, вероятно, нарушаете авторские 
права. Нарушение авторского права при сканировании является незаконным. 
В большинстве музыкальных произведений указана информация об авторских правах и правообладателе. Если у 
вас есть музыка, которую вы собираетесь отсканировать, но вы не уверены насчет статуса по вопросу авторских 
прав, лучше свяжитесь с издателем этой музыки, композитором или аранжировщиком. 



Пользователи Облегченной версии - Важная информация 
Пользователи Облегченной версии  
При использовании PhotoScore & NotateMe Lite (Облегченной версии) вы найдете, что многие пункты меню, 
кнопки на панели инструментов и флажки - постоянно серые. Это не ошибка - это просто недоступные функции в 
Облегченной версии. Если вы находите, что вам регулярно необходимо использовать «серые» опции, мы 
рекомендуем обновиться до Полной версии программы, PhotoScore & NotateMe Ultimate. 

 

 

 

 НАЧАЛО РАБОТЫ 
Запустите программу PhotoScore & NotateMe с помощью предпочитаемого вами метода (например, из 
Проводника, или из нотного редактора  Sibelius). 
Если это не было отключено, вы должны увидеть следующую панель инструментов ниже строки меню PhotoScore 
& NotateMe: 

 

 
Нажатие этих кнопок эквивалентно выбору пунктов меню File> Scan Pages… {Файл> Сканировать 

страницы…} (для сканирования страниц музыки), File>Open PDFs {Файл> Открыть файлы PDF…} (для 
преобразования PDF в музыкальные файлы), File>New NotateMe Score {Файл> Новая Партитура 

NotateMe} (для рукописного ввода со стилусом, пальцем или мышью, чтобы создать новые партитуры или 
отредактировать существующие - смотрите руководство пользователя NotateMe из меню Справки), и 
File>Open (Файл> Открыть) (для открытия сохраненных отсканированных изображений, файлов PhotoScore и 
файлов NotateMe), соответственно. Три кнопки справа соответствуют пунктам меню File> Preferences … 

{Файл> Установки…} (для изменения настроек PhotoScore), Help> View Help... {Справка> Просмотр 

Справки...} (для справки в формате PDF) и Справка> Веб-сайт Neuratron … (для веб-сайта Neuratron). 

Разрешение экрана и цвета 
Мы рекомендуем использовать PhotoScore на дисплее с высоким разрешением экрана, таким как 1024 x 768 или 
1280 x 1024. Дисплей с, по крайней мере, 16-битным качеством цветопередачи также рекомендуется. 

Три этапа 
Существует три основных этапа при использовании PhotoScore - Сканирование, Чтение(Распознавание) и 
Редактирование: 
1. Сканирование страницы просто заставляет PhotoScore сделать 'фотографию' вашего оригинала. Также 
возможно открыть файлы PDF, содержащие ноты. 
2. Распознавание (чтение) – это самый сложный момент: программа PhotoScore распознает ('читает') 
отсканированные страницы, стараясь найти на них ноты и другую разметку. 
3. Редактирование результирующей музыки - здесь вы исправляете любые ошибки, которые сделала 
программа PhotoScore. Редактирование в программе PhotoScore очень похоже на редактирование музыки в 
программе музыкальной нотации Sibelius. 
После выполнения вышеупомянутого, вы сможете транспонировать, воспроизвести, переформатировать, 
извлечь партии, распечатать, сохранить вашу музыку для использования в других музыкальных программах и 
даже записать вашу музыку на CD (не все функции доступны в Облегченной версии PhotoScore). 

 

 

 

1. СКАНИРОВАНИЕ 
 

Три интерфейса сканирования 
В зависимости от того, насколько вы хотите контролировать параметры сканера, PhotoScore предлагает до трех 
различных интерфейсов сканирования, в зависимости от версии Windows, которую вы используете, и 
возможностей программного обеспечения вашего сканера. Убедитесь, что программное обеспечение вашего 
сканера установлено и что ваш сканер включен и подключен к вашему компьютеру, и затем нажмите Scanner 



Setup … {Установки сканера…} из меню File {Файл} программы PhotoScore, чтобы увидеть доступные 
интерфейсы. Окно должно выглядеть примерно так: 

   
Автоматическое сканирование (не Облегченная версия) 
Если возможно (см. требования ниже), то программа PhotoScore автоматически выбирает подходящие настройки 
для вас и сразу выполняет сканирование, автоматически обрезая изображение впоследствии. 

Если ваш сканер очень долго сканирует каждую страницу, и вы не сканируете рукописную музыку, то 
поставьте галочку Scan more quickly (Быстрое сканирование), и PhotoScore будет сканировать в более 
низком разрешении (обычно 200 точек на дюйм вместо 300 точек на дюйм). 
Интерфейс PhotoScore 
Если возможно (см. требования ниже), интерфейс PhotoScore позволяет вам выбирать минимальную высоту 
нотоносцев на странице (-цах), которую вы сканируете, так, чтобы программа могла выбрать самое подходящее 
разрешение. При сканировании планшетным (flatbed) сканером (в противоположность сканеру с автоматическим 
устройством полистовой подачи (automatic sheet feeder)), это также позволяет вам выбирать область стекла 
сканера для сканирования. Это полезно, например, при сканировании книг формата A5, где более чем одна 
страница может уместиться на стекле сканера, так как PhotoScore может считывать только одну страницу за один 
проход. 
Интерфейс TWAIN 
Это - 'стандартный' интерфейс, который вы будете часто видеть при сканировании с другим программным 
обеспечением. Он обычно позволяет настраивать более продвинутые параметры сканера, например, 
пиксельный тип, яркость и контраст. Этот интерфейс является обычно самым полезным при сканировании очень 
ярко или бледно отпечатанной музыки, так чтобы подбор яркости мог быть настроен подходящим образом. 
Обратите внимание, что PhotoScore принимает только сканы, сделанные с разрешением между 72 dpi (в 
зависимости от качества сканирования) и 600 dpi, и с пиксельными типами черно-белым (также известным как 
b/w или 1-битным) или рекомендуемым, более аккуратным, 256 оттенков серого (также известным как 
черно-белое фото или 8-битные оттенки серого). Не выбирайте пиксельные типы  цветной, 12-битный, 
16-битный, 24-битный или 32-битный. Также убедитесь, что любой параметр масштабирования установлен на 
100% или 1:1, чтобы избежать изменения размеров изображения, прежде чем PhotoScore его увидит. Вот 
рекомендованные разрешения в зависимости от минимальной высоты нотоносцев и типов музыки, которую вы 
сканируете (рукописная музыка должна всегда сканироваться на уровне 300 dpi для лучших результатов): 

Высота нотоносца/тип Разрешение 

6 мм или больше 200dpi (200 точек на дюйм) 

4-6 мм 300dpi (300 точек на дюйм) 

3-4 мм 400dpi (400 точек на дюйм) 

    

Рукописная музыка 300dpi (300 точек на дюйм) 

Требования для интерфейсов Автоматического  и  PhotoScore: 
Windows: требуется Windows 2000/XP/Vista/7/8/10 с установленными драйверами WIA, совместимыми с моделью 
вашего сканера; при использовании более ранних версий Windows некоторые драйверы TWAIN также обеспечат 



эту функцию. Однако, если появляется сообщение, что ваш сканер не является полностью 
TWAIN-совместимым, или возникают другие проблемы, вам следует выбрать интерфейс TWAIN вместо этих. 
Как только вы выбрали свой предпочтительный интерфейс сканера, убедитесь, что ваш сканер выбран в 
выпадающем меню или диалоговом окне выбора сканера TWAIN (в состоянии ли вы выбрать из выпадающего 
меню, или диалогового окна выбора сканера TWAIN, - зависит от драйвера сканера, используемого PhotoScore). 
Остающиеся опции в диалоговом окне Установки Сканера (которое является также первой областью в 

Настройках PhotoScore) объяснены в разделе Настройки PhotoScore главы Расширенные функции. 
Сканирование страницы музыки 
Для вашего первого сканирования попробуйте страницу или две из простой клавишной музыки или чего-то 
подобного. Отметьте, что некоторые из этих инструкций применяются только при использовании планшетного 
сканера без автоматического устройства полистовой подачи. При использовании же автоматического устройства 
полистовой подачи (вероятно, вы будете знать, есть ли у вас оно), следуйте инструкциям, предоставленным с 
вашим сканером, для получения информации о размещении страницы: 
1 Поместите страницу с музыкой (‘оригинал’) в сканер текстом вниз, а начало страницы  дальше от себя. 

Один край оригинала выровняйте по краю стекла сканера. 
Можно положить страницу боком, если так удобней. Программа PhotoScore автоматически поворачивает 
страницу на 90 градусов при необходимости. Но обычно вам потребуется выровнять край страницы по 
левому краю сканера, чтобы быть уверенным, что страница не перевернута. Не переживайте, если 
страница все-таки перевернута - позже можно будет это исправить. 
Если вы выполняете сканирование в градациях серого, страницы не обязательно строго выравнивать, 
программа PhotoScore автоматически производит выравнивание оси страницы без потери точности. 
Программа поворачивает изображения и в режиме черно-белого сканирования, но при этом точность 
результатов снижается. 

2 Нажмите Scan Pages … {Сканировать страницы...} из меню File {Файл} программы PhotoScore 

или на панели инструментов. 
3 Что происходит, теперь зависит от интерфейса, выбранного в File> Scanner Setup… {Файл> 

Установки Сканера…}: 
Автоматический интерфейс сканирования: (не Облегченная версия): 
Ваш сканер должен начать работать почти сразу (хотя  ему может понадобиться время, чтобы 
прогреться, если он не использовался некоторое время).  
Интерфейс PhotoScore: 

 

   
 

Нажмите Select region to scan {Регион сканирования} (недоступно при использовании 
автоматического устройства полистовой подачи), чтобы заставить PhotoScore сделать быстрое 
сканирование всей области стекла сканера. Как только появится отсканированный 'предварительный 
просмотр' вашей страницы музыки, используйте мышь, чтобы щелкнуть и перетащить область, которую 
вы хотите считывать программой PhotoScore. Для корректировки существующей области щелкните и 
перетащите ее края. Затем нажмите Scan selected region {Сканировать выбранную область} на 
панели инструментов для возврата к исходному диалоговому окну, показанному выше. Ваша выбранная 
область будет использоваться для всех будущих сканирований, сделанных с помощью интерфейса 
PhotoScore, пока этот процесс выбора области не будет повторен. 
Наконец, выберите минимальную высоту нотоносцев, которые вы сканируете, и нажмите Scan 



{Сканировать}. Нажмите Cancel {Отмена}, если вы передумали и  больше не хотите сканировать. 
 

Интерфейс TWAIN: 
Выберите соответствующую область (обычно существует кнопка 'предварительного просмотра'), 
разрешение, пиксельный тип, подбор яркости и т.д. для вашего сканирования (консультируйтесь с 
руководством пользователя сканера, чтобы узнать, как, поскольку интерфейс варьируется от сканера к 
сканеру), и затем нажмите кнопку, помеченную Scan {Сканирование} (или эквивалентно). 

4 Через некоторое время сканер вернется к жизни, загудит и перенесет изображение страницы на ваш 
компьютер. (Если этого не произошло, см. Возможные проблемы ниже.) 
Если вы сканируете довольно толстую книгу, очень аккуратно прижмите крышку или саму книгу (если 
так проще) при сканировании, чтобы страница, уложенная на стекло, не выгибалась.  

5 Если не используется Автоматический интерфейс сканирования, то появится диалоговое окно, где 
можно ввести название страницы, где по умолчанию будет что-нибудь вроде Партитура 1, страница 1. 
Этот текст можно сменить на любой другой – например, вот так: Фортепиано стр.1 – а затем нажмите 
OK.  
Сканируемые далее страницы будут нумероваться автоматически, например, Фортепиано стр.2, и 
диалоговое окно не появится.  

6 Подождите несколько секунд, пока программа PhotoScore настроит уровни яркости, выберет лучшие 
значения для страницы и найдет нотоносцы. 

7 Программа PhotoScore теперь готова к сканированию следующей страницы, возможно после подсказки 
для ожидания сканера, чтобы прекратить трещать, поэтому положите ноты на сканер, нажмите кнопку 

Scan {Сканирование} (или эквивалентную) и выполните все как для первой страницы. Если интерфейс 
сканирования второй раз не появился, просто нажмите снова кнопку Scan Pages … {Сканировать 
страницы…} из меню File {Файл} или панели инструментов PhotoScore. 

8 Продолжайте выполнять эти действия, пока не отсканируете все желаемые страницы. 

 
О сканировании суммарно 
Если вы один раз отсканируете несколько страниц, то быстро выработаете у себя нужные навыки. Процедуру 
можно подытожить следующим образом: 
1 Положите страницу на сканер 
2 Нажмите Scan Pages… {Сканировать страницы…} из меню PhotoScore File {Файл} или  панели 

инструментов 

3 Если не используется Автоматический интерфейс сканирования, выберите высоту нотоносца или 
разрешение, и если используется интерфейс TWAIN, то либо сканируйте  в градациях серого 
черно-белую фотографию (рекомендуется), либо черно-белый  ч/б документ 

4 Если не используется Автоматический интерфейс сканирования, нажмите Scan {Сканировать} или 
эквивалент 

5 Если не используется Автоматический интерфейс сканирования, введите название страницы (или 
оставьте имя по умолчанию)  

6 Перейдите к следующей странице 

Каталог отсканированных страниц 
Важно, чтобы вы понимали, что когда бы вы ни сканировали страницу, программа PhotoScore добавит ее в 
единый список или ‘каталог’ отсканированных страниц для последующего распознавания. Вам не нужно где-то 
сохранять отсканированные страницы или каталог – они сохраняются у вас на жестком диске автоматически. 
Это означает, что каждый раз, когда вы запускаете программу PhotoScore, она все еще помнит любые страницы, 
которые вы отсканировали ранее. Вы можете и должны удалить страницы, которые вам больше не надо хранить. 
Позже мы расскажем об этом каталоге подробней. 
Каталог может быть просмотрен в Панели страниц (описано в начале следующей главы). 

Советы по сканированию 

 Если вы хотите распознать страницу нот, размер которой меньше, чем размер вашего сканера, то нужно 
проследить, что сканируется только нужная часть поля сканирования. 
Если вы используете интерфейс TWAIN, то необходимо будет прочитать предоставленную документацию 
драйвера TWAIN относительно того, как отсканировать только часть страницы. Для большинства сканеров у вас 
имеется возможность нажать кнопку ‘Предварительный просмотр’, чтобы посмотреть миниатюру изображения, 



которая может выглядеть несколько угловатой. Затем вы можете настроить нужную область сканирования по 
краям миниатюры. 
После этого нажмите кнопку Сканировать для сканирования области с высоким разрешением. Каждый раз, когда 
вы после этого нажимаете кнопку Сканировать, сканируется только выбранная область, пока вы не укажете 
другую. 

 Убедитесь, что все сканируемые ноты на странице уместились на стекле сканера, и что никакая музыка 
из другого листа разворота не сканируется. Не важно, если ваш оригинал больше формата A4, главное, чтобы 
сама музыка укладывалась в этот формат. 

 Если вы сканируете страницу, размеры которой меньше формата A4, то не имеет значения, где именно 
на стекле сканера размещена страница. Однако лучше прижать край страницы к краю стекла, чтобы убедиться, 
что страница установлена ровно. 

 Если первая страница, которую вы сканируете, имеет номер страницы 3 (допустим), напечатанный на 
ней, а не 1, то меньше собьет с толку, если вы назовете страницу (допустим) Фортепьяно с3, а не 

Фортепьяно с1. 
 Если вы сканируете нотную книгу маленького формата, может оказаться, что на сканере умещается 
двухстраничный разворот (две соседних страницы рядом), но не пытайтесь их сканировать в таком положении 
одновременно – программа PhotoScore способна распознавать лишь по одной странице за раз. Сканируйте 
каждую страницу отдельно. 

 Для упрощения процесса, мы рекомендуем отсканировать все страницы пьесы, а потом запустить их 
распознавание. Можно сканировать страницу, затем распознавать ее, потом сканировать следующую и т.д. (см. 
Расширенные функции ниже), но мы не советуем вам так делать, пока вы не освоите программу PhotoScore 
достаточно хорошо. 

Длинные партитуры 
Если вы хотите отсканировать партитуру больше чем из нескольких страниц, отсканируйте и распознайте 
сначала пробную страницу, чтобы проверить, что сканер и другие настройки корректны. 
Если вы будете использовать первую страницу в качестве пробной, и она распознается правильно, то не будет 
нужды повторно ее сканировать. Продолжите сканировать со второй страницы; вы обнаружите, что, когда вы 
отсканировали и распознали все страницы, они будут добавлены в правильном порядке после первой страницы. 
PhotoScore может сканировать партитуры до 400 страниц (Облегченная версия - 20 страниц), хотя для партитур 
из 40 страниц или больше вам настоятельно рекомендуется разделить их на отдельные пьесы, песни, части или 
другие удобные разделы, и сканировать, распознавать и редактировать каждый раздел  отдельно. 

Открытие файлов JPEG, TIFF и BMP 
PhotoScore может открывать файлы JPEG, созданные камерой, а также файлы TIFF и BMP. Последние два 
полезны, если ваш сканер находится на отдельном компьютере от программы PhotoScore, поскольку вы сможете 
отсканировать и сохранить эти файлы, а затем транспортировать их на компьютер с PhotoScore для открытия. 
Открывайте все три из этих типов файлов из меню File> Open… {Файл> Открыть…}, убедившись, что 
соответствующий тип файла выбран в Файлы типа… выпадающего меню. 
Файлы JPEG должны быть фотографиями, сделанными камерой в разрешении не меньше, чем 4MP (4 
мегапиксела). Разрешение 8MP рекомендуется. Отсканированные файлы должны сканироваться с подходящим 
разрешением и должны быть черно-белые (2 цвета) или 256 оттенков серого. Множество файлов может быть 
выбрано и открыто одновременно. Файлы TIFF, содержащие множественные изображения, могут также быть 
открыты. 

Открытие файлов PDF 
Программа PhotoScore может открывать и распознавать файлы PDF. Открывайте файлы PDF с помощью File> 

Open PDFs… {Файл> Открыть PDF…}. Если файл будет защищен, то PhotoScore попросит, чтобы вы ввели 
подходящий пароль. 
Для PDF более чем с одной страницей вам дается возможность сообщить PhotoScore, какие страницы вы хотели 
бы открыть и распознать. Это особенно полезно, если вы хотите только открыть одну часть/раздел из PDF с 
крупным произведением, или если PDF имеет титульный лист, который не должен быть считан PhotoScore. 
Для открытия всех страниц в PDF, просто нажмите "OK". Для открытия диапазона страниц, введите номера 
первой и последней страницы с дефисом между ними. Отдельная страница может быть открыта путем ввода 
ее номера страницы, и множество отдельных страниц могут быть открыты введением их номеров с запятыми 
между ними. Множество диапазонов страниц могут также быть открыты посредством комбинированного 
использования дефисов и запятых. После нажатия "ОК" для продолжения, удержите нажатым Escape, если вы 
решаете, что хотите остановить открытие файла программой PhotoScore. 



Множество файлов PDF могут быть открыты одновременно. Для каждого PDF программа PhotoScore 
автоматически создает отдельную партитуру в Панели Чтения Страниц (Read Pages) (см. главу 2. 
РАСПОЗНАВАНИЕ (ЧТЕНИЕ)). Если PDF’ы перетащены на PhotoScore или установлены быть считанными 
автоматически программой PhotoScore (см. Распознавание и Панель Страниц в главе 2. РАСПОЗНАВАНИЕ 
(ЧТЕНИЕ)), каждая партитура будет автоматически сохранена. Таким образом, программу PhotoScore можно 
оставить работать над всей библиотекой файлов PDF на ночь, без опасений перед сбоем питания, 
аннулирующим всю ее тяжелую работу. 
 
 
 

 2. РАСПОЗНАВАНИЕ (ЧТЕНИЕ) 
Как упоминалось ранее, с точки зрения компьютера, отсканированная страница – всего лишь сетка из миллионов 
черных и белых точек, которые могут быть чем угодно, от текста до фотографий. 
Распознавание музыки – это самый сложный момент, когда программа PhotoScore старается найти на 
отсканированных страницах ноты и другую разметку. 
 

Распознавание и Панель страниц 
Вы должны увидеть Панель страниц (ниже) в левой части окна программы PhotoScore. В противном случае 
можно увидеть ее путем выбора View> Toggle Pages Pane {Вид> Показать/скрыть панель страниц}. 
Также изменяйте ее размеры с помощью двойного щелчка или перетаскивания ее правого края. 
Самая правая картинка показывает, как изменился вид Панели страниц в последней версии PhotoScore 8.8.2. 

 

        
 (Примечание: Если вы применяли PhotoScore 4 или более ранней версии, эта Панель заменяет диалоговое 
окно Scanned pages {Cканируемые страницы}, которое было доступно по кнопке на панели инструментов 
View Pages {Просмотр страниц} и через пункт меню View> Scanned pages… {Вид> Сканируемые 

страницы…}.) 
Панель страниц разделена на две основные части, Pending Pages (сейчас Scans) {Сканы (ожидающие 

чтения)} и Read Pages (сейчас Scores) {Партитуры}. 

Ожидающие чтения страницы 
В самом верху этой области можно выбрать, должна ли следующая страница, которая будет читаться, быть 
прочитана как печатная или рукописная музыка (не Облегченная версия). Очень важно, чтобы вы выбрали 
корректную опцию перед открытием/сканированием/чтением страниц, иначе, точность распознавания будет 
очень плоха. 
Ниже этого показывается список страниц музыки, которые были отсканированы или открыты из файлов PDF, 
JPEG, TIFF и BMP, и которые еще не были распознаны программой PhotoScore. Когда вы наводите мышку на их 
название, будет отображаться миниатюра страницы. Нажатие на миниатюру или двойной щелчок по названию 
страницы выводят на экран исходную страницу в окне справа. Это полезно для проверки, была ли страница 
отсканирована правильно. 



Когда вы проводите курсором мыши над названием страницы, появляется справа небольшой прямоугольный 
флажок с надписью Read (Распознавать). [Если флажок отмечен зеленым, это означает, что она ожидает 
распознавания.] Когда вы решите запустить распознавание отсканированной страницы, нажмите на флажок Read 
(Распознавать). Программа PhotoScore начнет распознавание всех страниц с зеленым прямоугольником в 
порядке сверху донизу.  
Если Read pages after scanning/opening {Сканирование>Читать сразу после обработки} будут 
выбраны в Установках (см. главу Расширенные функции), то каждой странице, отсканированной или открытой 
из файла, будет установлен этот флажок, и она автоматически будет читаться/распознаваться. 
Возможно перетащить ожидающую чтения страницу вверх или вниз в списке для изменения порядка, в котором 
она появляется в выходной партитуре (если был перепутан порядок сканирования). 
В то время как страница читается/распознается, прогресс будет показан зеленым прямоугольником, 
заполняющим элемент списка слева направо. Кроме того, удерживание мыши над ним покажет Cancel 

{Отмена} вместо Read {Чтение}, и щелчок по нему отменит чтение этой страницы. Это занимает момент для 
отмены, и в это время Cancelling {Отмена} будет выведено на экран, и флажок будет отмечен красным. 
Щелчок по названию страницы выбирает его и окрашивает его в синий цвет. Дополнительные страницы могут 
быть выбраны удержанием Ctrl (для добавления отдельных страниц) или Shift (для добавления серий 
страниц) при щелчке. Щелчок по Read {Чтение} или Cancel {Отмена} на выбранной странице повлечет то же 
действие для всех других выбранных страниц. Поэтому возможно выбрать несколько страниц и одним щелчком, 
выбрать, должны ли они все быть считаны/распознаны. Щелчок на надписи Remove {Удалить} на выбранной 
странице – позволяет удалить все выбранные страницы. 
По мере прочтения каждой страницы, распознанная музыка добавляется к выходной партитуре справа от Панели 
страниц. Можно редактировать вывод, пока PhotoScore читает остающиеся страницы. Список страниц также 
перемещается из области Pending Pages {Ожидающие чтения партитуры} в область Read Pages 

{Распознанные партитуры}, как описано далее. 
Распознанные Партитуры 
По мере прочтения каждой ожидающей страницы, она перемещается в эту область. Страницы сгруппированы в 
партитуры, чтобы облегчить управление ими. Страницы, принадлежащие партитуре, можно показать или скрыть 
путем нажатия на маленький + или - слева от имени партитуры (с синим фоном). Двойной щелчок по имени 
партитуры открывает файл PhotoScore, связанный с партитурой, а также показывает страницы, которые 
составляют ее. Когда партитура открыта, щелчок по Remove {Удалить} справа от имени партитуры удаляет 
ее из области Read Pages {Распознанные Партитуры}. 
Если в настройках PhotoScore будет «читать страницы автоматически после сканирования/открытия» или если 
вы открыли файлы путем перетаскивания их на иконку PhotoScore, то каждая партитура будет сохранена 
автоматически. Редактирования, впоследствии сделанные в этой партитуре, будут также сохранены 
автоматически. Щелчок по Remove {Удалить} справа от имени партитуры также удаляет выходную партитуру. 
Для сохранения сохраняемой автоматически партитуры в местоположении по вашему выбору, щелкните File> 

Save As… {Файл> Сохранить как…} (см. Сохранение файлов PhotoScore (.opt) в главе ПОСЛЕ 
ВЫПОЛНЕНИЯ PHOTOSCORE). После выполнения этого, больше не будут сохраняться автоматически 
дальнейшие редактирования. Кроме того, щелчок по Remove {Удалить} справа от имени партитуры больше не 
будет удалять выходную партитуру. 
Если вы хотите прочитать ряд страниц в новую партитуру, сначала необходимо закрыть текущую выходную 
партитуру с правой стороны путем выбора File> Close Score {Файл> Закрыть партитуру} или щелчком по 
маленькому крестику в правом верхнем углу. (Если партитура не была сохранена автоматически, необходимо 
будет сначала сохранить партитуру.) Новые прочитанные страницы тогда появятся под новым синим заголовком 
партитуры. 
Перемещение мыши по прочитанным страницам выведет на экран миниатюру исходной отсканированной 
страницы слева и также представление выходной страницы справа. 
Нажатие на миниатюру слева выводит на экран исходную страницу в окне справа, это полезно для проверки, 
что PhotoScore правильно определила местоположение нотоносцев, если вывод выглядит странным. Все 
нотоносцы должны быть полужирным шрифтом выделены синим цветом с корректным количеством показанных 
строк нотоносцев, и все нотоносцы внутри каждой системы должны быть объединены слева вертикальной 
красной линией. Если не все нотоносцы выделены голубым или не все нотоносцы в системах объединены 
красной линией, можно вручную указать программе PhotoScore, где они находятся. Для получения 
дополнительной информации смотрите разделы Adjusting detected staves/systems {Настройка обнаруженных 
нотоносцев/систем} и Scan window options {Опции окна сканирования} в главе Расширенные функции. 
Нажатие на правую миниатюру высвечивает выходную страницу в окне справа. Если страница принадлежит 



другой партитуре, PhotoScore закроет открытую в настоящее время партитуру для открытия другой. Только один 
файл PhotoScore может быть открыт одновременно. 
Страницы, которые были прочитаны, но не отредактированы, показываются с символом * слева от названия 
страницы, чтобы напомнить вам, что любые ошибки могли быть еще не исправлены. 
Если название страницы написано полужирным, это означает, что данная страница выводится на экран справа. 
Щелчок по Remove {Удалить} на выбранной странице в области Pending Pages {Ожидающие чтения} 

удаляет эту страницу с вашего жесткого диска. Если вы делаете то же в области Read Pages {Распознанные 

партитуры}, то PhotoScore сохраняет страницу в течение недели, прежде чем постоянно удалить ее. Страница 
перечисляется в списке только когда выходная партитура, с которой она связана, открыта. В этом случае Keep 

{Оставить} выведено на экран вместо Remove {Удалить} и может быть нажато для предотвращения 
удаления. Это может быть полезно, если вы удаляете одну или более страниц, но потом обнаруживаете или 
решаете, что над партитурой требуется дополнительная работа. 
 
 

Что распознаёт программа PhotoScore (распечатанная музыка) 
Программа PhotoScore распознаёт большинство музыкальных символов, включая: 

 Ноты и аккорды (в том числе направление штилей, ребра и флажки), паузы. 
Полная версия также читает форшлаги и ноты-перебежчики (с одного нотоносца на другой). 

 Знаки альтерации. Полная версия также читает знаки артикуляции 

 Ключи, ключевые знаки, метрические размеры 

 Системы, 5-линеечные нотоносцы (обычные и уменьшенные), 6-линеечные табулатуры для гитары, 
стандартные тактовые черты. Полная версия также читает 4- и, 1-, 2-, 3- и 5-линеечные нотоносцы ударных, 
двойные тактовые черты и репризы 

 Формат страницы, в том числе размер страницы, размер нотоносца, поля и окончания системы. 

 Связующие лиги. Полная версия также читает фразировочные лиги и вилки. Для включения/отключения 
распознавания фразировочной лиги, связующей лиги и вилки, смотрите Расширенные функции 

 Туплеты (Облегченная версия - только простые триоли). Для распознавания программой PhotoScore 
туплетов должно быть включено Tuplets (includes advanced rhythm detection) {Туплеты (включает 

усовершенствованное обнаружение ритма)} (см. Расширенные функции), 
Только Полная версия: 

 Текст, в том числе вокальный текст, динамические обозначения, темп, названия инструментов, заглавие 
и композитора, обозначения гитарных аккордов и аппликатуру. Подробнее о распознавании текста см. в 

Расширенных функциях 

 Схемы (диаграммы) гитарных аккордов. Для включения/отключения распознавания схем гитарных 
аккордов, смотрите Расширенные функции 

 Различные другие пометки, такие как знаки кода, знаки сэньо, мелизмы, обозначения педали и вольты, 
см. Расширенные функции 

PhotoScore проигнорирует менее общие пометки, включая некоторые строки наподобие 8va, специальные 
нотные головки и тремоло. 
Все эти пометки могут быть добавлены обратно в партитуру в музыкальных программах, таких как Sibelius. 
 

Что распознаёт программа PhotoScore (рукописная музыка) 
PhotoScore может распознавать следующие рукописные пометки в отсканированной музыке: 

 Ноты и аккорды (в том числе направления штилей, ребра и флажки, точки увеличения), паузы 

 Знаки альтерации 

 Ключевые знаки 

 Метрические размеры вычисляются по музыке (не специально считываются) 

 Системы, 5-линеечные нотоносцы, тактовые черты 

 Связующие лиги и фразировочные лиги. Для включения/отключения распознавания связующих и 
фразировочных лиг  см. Расширенные функции 

 Формат страницы, в том числе размер страницы, размер нотоносца, поля и окончания системы 
 
 
 



 3.  РЕДАКТИРОВАНИЕ 
Когда каждая страница считана в Панель страниц, интерпретация её программой PhotoScore появляется в новом 
окне справа, которое называется окном вывода. Здесь можно отредактировать любые ошибки, которые были 
сделаны программой. 
Чтобы освободить больше места для редактирования музыки, можно скрыть Панель страниц при редактировании 
с помощью команды View> Toggle Pages Pane {Вид> Включить/выключить панель страниц} (сочетание 
клавиш Ctrl+E). 
Быстрое руководство по редактированию  

 Для выбора объекта щелкните на нем так, чтобы он приобрел другой цвет. Для изменения выбранной 
ноты внутри аккорда удерживайте Alt при использовании стрелок вверх/вниз управления курсором. Для 
выбора целого аккорда дважды щелкните в центре одной из его нот.  

 Ноты могут быть перетащены вверх и вниз с помощью мыши или клавишами вверх/вниз управления 
курсором.  

 Для добавления ноты щелкните по длительности ноты на 'клавиатуре' в правом нижнем углу окна, затем 
щелкните на нотоносце для ввода ноты на той высоте, где вы щелкаете. Кнопка ‘клавиатуры’ остается 
нажатой, так что можно щелкать ещё, вводя больше нот на нотоносце. Введите несколько нот, одна над 
другой, для создания аккорда. Чтобы прекратить создавать ноты, нажмите Esc для отмены выбора всех 
кнопок ‘клавиатуры’. Нота может быть быстро добавлена к существующему аккорду путем выбора аккорда и 
двойного щелчка в желаемой позиции.  

 Чтобы отредактировать ноты: можно выбрать ноту и отредактировать ее направление штиля, знаки 
артикуляции, знаки альтерации, и т.д., просто выбором соответствующей кнопки ‘клавиатуры’. Для 
редактирования длительности ноты выберите длительность ноты на ‘клавиатуре’. Флажок или луч могут 
также быть выбраны таким образом. Нажимайте стрелки влево/вправо для перемещения между нотами.  

 Чтобы добавлять/редактировать паузы: Для добавления пауз сделайте то же, что и для добавления 
ноты, но также и нажмите на нижнюю левую кнопку паузы на ‘клавиатуре’ для преобразования ноты в паузу. 
Паузы могут быть отредактированы таким же образом, как ноты.  

 Чтобы увидеть более экзотические наборы символов, щелкайте на пяти кнопках наверху ‘клавиатуры’.  

 Чтобы изменить голос ноты или паузы, щелкните на одной из кнопок, помеченных 1 2 3 4 внизу 
‘клавиатуры’ (только голос 1 и 2 в Облегченной версии). Индивидуальные ноты из аккорда могут быть 
разделены по различным голосам, и аккорды в различных голосах могут быть объединены в единый аккорд 
таким же образом.  

 Чтобы скопировать и вставить, вы можете использовать Ctrl+C и Ctrl+V соответственно (щелкнув, где вы 
хотите вставить), но быстрее продублировать объект одним действием, выбрав его, указав в другое место и 
щелкнув с удержанием клавиши Alt. Попробуйте это с нотой или с каким-либо текстом. Множество нот, 
которые принадлежат тому же нотоносцу, могут также быть скопированы и вставлены одновременно.  

 Для удаления выбранных объектов нажмите Delete.  

 Чтобы отредактировать ноты гитарной табулатуры: номер лада ноты может быть введен с помощью 
цифровых клавиш.  

 Чтобы отредактировать другие объекты: Большинство объектов, таких как ключи, метрические размеры 
и тактовые черты, может быть изменено двойным щелчком или щелчком правой кнопки по ним для 
активизации соответствующего диалогового окна или меню.  

 Чтобы создать другие объекты: вы можете создавать другие объекты (например, ключи, метрические 
размеры) из меню Create {Создать}, которое можно также получить, щелкнув правой кнопкой мыши. 
Выберите объект из меню, и затем щелкните на партитуре для создания его.  

 Чтобы изменить местоположение/изменить размеры объектов: Большинство объектов может быть 
перемещено по странице с помощью щелчка и перетаскивания. Некоторые объекты, такие как 
фразировочные лиги и вилки, могут быть изменены в размере подобным же образом, посредством щелчка и 
перетаскивания их левых или правых краев.  

 
В верхней части окна (с немного желтоватым фоном) отображается исходная сканируемая страница. 
Окно ‘Подробный просмотр’ в правой верхней части отображает увеличенную часть исходной страницы, на 
которую в данный момент указывает курсор мыши. 
Большая нижняя часть окна (со светло-серым фоном) отображает интерпретацию программой PhotoScore 
произведенного сканирования – т.е. то, что программа PhotoScore сумела распознать на странице оригинала. 



Точность интерпретации PhotoScore зависит от нескольких факторов, таких как качество исходной печати, 
разрешение сканера, и т.д. Таким образом, именно в этой части окна можно заметить ошибки, сделанные 
программой PhotoScore. 
Если вы не видите верхнюю часть окна, это означает, что PhotoScore не может определить местоположение 
исходной отсканированной страницы (например, если она была удалена); всё окно вывода будет тогда иметь 
белый фон. 
В верхнем левом углу окна помечено, например, Страница 1 из 7, и щелкая по стрелкам, можно 
перемещаться по всем страницам, которые были прочитаны. Есть смысл полностью отредактировать первую 
страницу, а затем перейти ко второй странице, и так далее, пока не отредактируете всю партитуру. Значок лупы 
масштабирует страницу для заполнения окна; 100 масштабирует до 100%; 200 масштабирует до 200%. 
В нижней правой части окна расположена ‘цифровая клавиатура’ (функции которой похожи на цифровую 
клавиатуру программы Sibelius). ‘Клавиатуру’ можно перемещать, если щелкнуть по ее заголовку и тащить 
мышкой. Она имеет два альтернативных макета, которые могут быть переключены путем щелчка по маленькому 
значку двунаправленной стрелки в ее правом нижнем углу. Один макет представляет все кнопки на 
единственной панели, его легче использовать для большинства новичков. Другой макет подобен ‘клавиатуре’ в 
нотном редакторе Sibelius и соответствует цифровой клавиатуре справа от вашей компьютерной клавиатуры. 
Эти клавиши могут быть нажаты вместо использования мыши. Можно выбрать несколько клавиш вместе (но 
сначала ввести длительность ноты), например, введите 4. - / для получения четвертной ноты с точкой, с 
tenuto (‘выдержанно’) и акцентом. 
Как говорилось выше, окно ‘Подробный просмотр’ в правой верхней части окна вывода отображает увеличенную 
часть исходной страницы, на которую в данный момент указывает курсор мыши. Оно может быть перемещено и 
изменено в размере, как обычное окно. И оно и ‘клавиатура’ могут быть удалены путем снятия ‘галочек’ с 
соответствующих опций в меню View {Вид}. 
В строке меню существует меню Create {Создать}, которое подобно меню Create в программе Sibelius (при 
щелчке правой кнопкой мыши на партитуре без выделения фрагмента музыки). Функции редактирования, не 
подходящие для PhotoScore, были опущены. 

Что нужно исправлять 
Минимальный рекомендуемый уровень исправлений перед отправкой партитуры в другую музыкальную 
программу: проверьте знаки при ключе и метрические размеры (т.е. ошибки ритма). Другие ошибки, например, 
неверную высоту нот, можно исправить уже позже, но исправить тональность и размер гораздо проще в 
программе PhotoScore, что мы и рекомендуем сделать. 
Как только вы станете более опытными с программой PhotoScore, можно исправлять музыку полностью в 
PhotoScore, прежде чем отправить ее в другую программу. Преимущество здесь в том, что вы можете 
локализовать ошибки, глядя на сканируемый оригинал на экране, тогда вам не придется сверяться с его 
бумажной копией. 

Проверка на ошибки 
Проверять на ошибки следует сравнивая нижнюю часть окна с исходным сканом сверху. Верхняя и нижняя части 
окна движутся синхронно, чтобы отслеживать положение курсора мыши. 
Не поддавайтесь соблазну сверять страницу вывода с исходной партитурой на бумаге – почти всегда сравнивать 
их на экране будет быстрее.  

Мышь и клавиши 
Вообще говоря, вы можете: 

 выбирать и перемещать пометки с помощью (левой) кнопки мыши 

 копировать пометки с помощью Alt-щелчка или щелчка средней кнопкой мыши. 

 создавать пометки с помощью меню Create {Создать} 

 удалять пометки с помощью Delete 

 редактировать ноты и паузы с помощью ‘клавиатуры’. 

Выбор 
Чтобы выбрать пометку: 

 Укажите мышью на пометку так, чтобы она подсветилась фиолетовым полем 

 Щелкните (левой) кнопкой мыши – пометка станет синей, если она в голосе 1, зеленой, если в голосе 2, 
оранжевой, если в голосе 3, или фиолетовой, если в голосе 4. 
Также возможно перемещаться влево и вправо для выбора других пометок при помощи клавиш со стрелками 
влево и вправо. Держите Ctrl нажатой в то же время для перехода к началу текущего или следующего такта. 
Фиолетовое поле облегчает сравнение верхней и нижней частей окна вывода, и также помогает вам выбрать 



намеченную пометку, когда музыка заполняет страницу слишком плотно. 
Обратите внимание, что в нижней части окна только нотоносец, где находится сейчас курсор мыши, выделен 
белым. Этот нотоносец соответствует части отсканированного изображения, выведенной на экран наверху окна. 

Множественный выбор 
Обратите внимание, что можно выбрать несколько пометок сразу удержанием (левой) кнопки мыши и 
перетаскиванием рамки вокруг пометок, которые будут выбраны. Можно тогда отредактировать или удалить все 
пометки сразу. При выборе нескольких нот можно также вырезать или скопировать и вставлять их. Это может 
сэкономить много времени. Альтернативно можно выбрать дальнейшие отдельные ноты удержанием Ctrl, или 
серии нот удержанием Shift и щелчками. 
Пользователи Sibelius  
Когда Sibelius установлен, множество пометок может быть выбрано таким же образом, как в Sibelius, удержанием 
Shift, щелкая по ним и перетаскивая. 
Также возможно выбрать дополнительные пометки слева и справа удержанием Shift при использовании 
клавиш со стрелками влево и вправо. Так же используйте Ctrl+Shift для выбора до начала или конца такта. 

Положение пометок 
PhotoScore позиционирует пометки везде, где их видит (или думает, что их видит), на странице. Программа не 
пытается перемакетировать музыку. Поэтому PhotoScore вполне довольна, когда пометки накладываются друг 
на друга или не выровнены. Вы можете щелкнуть и перетащить большинство объектов влево и вправо, если они 
накладываются. 
Заметьте, что можно сказать программе PhotoScore, чтобы она переформатировала всю партитуру (не 
Облегченная версия) – см. Переформатирование и извлечение партий в главе ПОСЛЕ ВЫПОЛНЕНИЯ 
PHOTOSCORE. 

Перечитывание (повторное распознавание) страницы 
Если вы хотите перечитать страницу, возможно потому, что вы скорректировали установки распознавания, 
дважды щелкните по желтоватой верхней части окна вывода для просмотра скана, затем щелкните на Read 

this page {Читать эту страницу}. Можно также выбрать, где получающаяся страница должна очутиться в 
выходной партитуре, путем щелчка по маленькой стрелке сразу справа от Read this page {Читать эту 

страницу} и затем выбора одной из доступных опций. 

Пересканирование страницы 
Если вы хотите повторно отсканировать страницу после чтения ее - возможно, если использовались 
несоответствующие установки сканера – сделайте двойной щелчок по желтоватой верхней части окна вывода, 
чтобы попасть в сканирование, затем нажмите на Re-scan {Пересканировать}. После сканирования нажмите 

Read this page {Читать эту страницу} наверху окна для считывания/ распознавания  ее. 

Удаление страницы 
Выбор из меню Edit> Delete page {Правка> Удалить страницу} удаляет высвечиваемую сейчас на экран 
страницу из выходной партитуры; это полезно, если вы случайно отсканировали ту же страницу дважды. 
Не используйте это, если вы хотите повторно отсканировать страницу, поскольку PhotoScore добавляет недавно 
отсканированные страницы в конец выходной партитуры, вместо того, чтобы вставить их в середину. Вместо 
этого, см. Пересканирование страницы (выше). 
 

РЕДАКТИРОВАНИЕ РИТМА И КЛЮЧЕВЫХ ЗНАКОВ 
Ритм является основным источником ошибок, потому что ритмы более трудно считывать, чем высоту. 
Пользователи Sibelius  
В отличие от Sibelius, программа PhotoScore не 'расширяет' такты паузами, чтобы обеспечить нужную сумму 
длительностей, потому что не всегда очевидно, в которой части такта недостает ритма. 
Обратите внимание, что, когда вы добавляете музыкальные объекты на нотоносец, никакое дополнительное 
пространство не появляется для них, так что заполнение может стать слишком плотным. Не беспокойтесь об 
этом, поскольку музыка повторно размещается с нужными промежутками, когда она отправляется в Sibelius.  
Если пункт меню View> Bad Timing {Вид> Неверный музыкальный счет} отмечен ‘галочкой’, то любой 
такт, который, как кажется, имеет слишком мало или слишком много нот в любом голосе, помечается 
горизонтальными красными пунктирными линиями выше и ниже его, и PhotoScore изображает (справа вверху 
такта), в цвете, соответствующем голосу, сколько ритма недостает или в избытке. Например, если такт, как 
кажется, имеет избыточную четвертную ноту плюс шестнадцатую ноту, то PhotoScore запишет ‘+’, за которым 
следует изображение четвертной ноты и шестнадцатой ноты. С другой стороны, если такт будет, как кажется, 
короче на половинную ноту, то PhotoScore запишет ‘-’, за которым следует изображение половинной ноты. 



Нотная головка с маленькими цифрами 3 или 4 над ней обозначает 1/32-ю ноту или 1/64-ю ноту. 

 
Вертикальная красная пунктирная линия проводится в конце нотоносца, если конечная тактовая черта 
отсутствует (намеренно или нет). Если только такт не разделен по нотоносцам, то тактовые черты должны быть 
добавлены для пометки конца такта. Если такт разделен по нотоносцам, то любые предупреждения по ритму 
выводятся на экран только в последнем нотоносце. 
Процедура для использования при исправлении ритма должна сначала проверить, что задано корректное 
обозначение метрического размера. Затем посмотрите на каждый такт, выделенный горизонтальными 
красными пунктирными линиями, и исправьте ритм в каждом такте, пока красные линии не исчезнут. Когда 
на странице не осталось никаких горизонтальных красных пунктирных линий, тогда вы можете быть 
уверены, что она ритмически корректна. 

          
 

       
 

Навигатор неверного счета (ошибок ритма) (не Облегченная версия) 

Чтобы помочь вам локализовать и перемещаться к ритмически некорректным тактам в партитуре, Полная 
версия PhotoScore предоставляет навигатор, который перечисляет их. По умолчанию навигатор неверного счета 
(плохой синхронизации) расположен в нижней левой части окна PhotoScore и высвечивается каждый раз, когда 
партитура открыта. Его местоположение может быть изменено с помощью щелчка и перетаскивания его строки 
заголовка. Если вы не видите навигатор, нажмите View> Bad Timing Navigator {Вид> Навигатор неверного 

счета}. 
Щелчок на каждой записи, перечисленной в навигаторе, приведет вас прямо к этому такту в партитуре. Когда 
запись выбрана в навигаторе, она выделена красным фоном, и красные пунктирные линии выше и ниже такта в 
партитуре становятся сплошными. Если в партитуре нет никаких тактов с ритмическими ошибками, то 
выводится сообщение No bad timing found {Неверный счет не найден}. 

Начальное обозначение метрического размера 
Если не будет никакого обозначения метрического размера в начале первой выходной страницы, то PhotoScore 
примет обозначение размера 4/4. Так что, если это неправильно, то первая вещь, которую вам необходимо 
сделать, это ввести начальное обозначение метрического размера. 



Чтобы сделать это, укажите на выходную страницу и сделайте щелчок правой кнопкой мыши (на экране 
высветится то же меню, как и при нажатии на Create {Создать}) и выберите обозначение метрического 
размера из диалогового окна, открывающегося при нажатии на Time signature {Обозначение метра}. Могут 
быть выбраны общие метрические размеры, или можно создать собственный. 
Вставьте обозначение метрического размера в начале партитуры посредством аккуратного расположения синего 
указателя после начального ключа. Если вы получаете фиолетовое поле вместо темно-синей линии, то 
указатель находится над пометкой, и вы не сможете вставить обозначение метрического размера. 
Тот же принцип применим при размещении любой другой пометки – вы можете расположить пометки только 
там, где появляется темно-синяя вертикальная линия. Если вы получаете фиолетовое поле, то выделенная 
пометка будет заменена новой (только если не будут вовлечены пометки двух различных типов, в этом случае 
ничего не произойдет). 
Если в настройках PhotoScore включена опция Reading> Tuplets (includes advanced rhythm detection) 

{Чтение> Туплеты (доп.определение ритма)} (см. Расширенные функции), то вы можете обнаружить 
красное обозначение метрического размера, помещенное в начале страницы. В этом нет ничего тревожного, 
поскольку это только показывает, что программа PhotoScore не смогла найти обозначение метрического 
размера на странице во время считывания, и предположила его таким. Это может быть отредактировано или 
удалено точно так же, как любое другое обозначение размера. 

Затакт / неполные такты 
Партитуры часто начинаются с короткого такта, известного как 'затакт'. Такие неполные такты, которые не 
составляют в сумме метрический размер, требуют специального рассмотрения. Необходимо вставить два 
скрытых метрических размера (существует флажок Hide {Скрыть} в диалоговом окне Create> Time signature 

{Создать> Обозначение метра}). Первый должен быть вставлен в начале неполного такта и должен иметь 
значение, которое соответствует длительности этого такта. Второй должен быть той же величины, что и 
исходный метрический размер, и должен быть помещен в начале следующего такта, чтобы размер вернулся к 
нормальному. 

Ключевые знаки / транспонирующие инструменты 
Создавайте знаки ключа из меню Create {Создать}. Нормальное поведение для PhotoScore – это создание 
индивидуальных ключевых знаков для каждого нотоносца. Если вы хотите создать ключевые знаки для всех 
нотоносцев в системе (например, если там нет транспонирующих инструментов), держите нажатой Ctrl, когда 
размещаете их. Аналогично, удаление обычным способом удалит индивидуальные ключевые знаки из 
нотоносца, тогда как удержание Ctrl при удалении - удалит все ключевые знаки из системы. Вам следует всегда 
удостоверяться, что существуют ключевые знаки на каждом нотоносце в системе (или ни одного на любом), 
когда добавляете или изменяете множество ключей одновременно - иначе другие ключевые знаки могут быть 
затронуты или продублированы. 
Пользователи Sibelius  
Остерегайтесь того, если ключевые знаки будут иметь корректное количество диезов/бемолей в одной системе, 
но неправильное количество в следующей, и вы не исправите это, начало последней системы будет 
рассматриваться как изменение тональности, когда музыка будет отправлена в Sibelius.  
Пользователи Sibelius v2 или более высоких версий: При передаче транспонируемой партитуры в Sibelius 
убедитесь, что выставлен флажок This is a transposing score {Это транспонируемая партитура} в диалоговом 
окне Sibelius  Open PhotoScore file {Открыть файл PhotoScore}. 

Изменение длительности нот 
Для изменения длительности ноты просто выберите ноту или паузу, которой это касается, и затем используйте 
‘клавиатуру’. 
Если несколько нот имеют неправильную длительность ноты, примите во внимание, что вы можете перетащить 
рамку выделения вокруг них, чтобы выбрать их все, и затем исправить их все единственным нажатием клавиши. 

Добавление нот/пауз 
Для добавления ноты где-либо, используйте ‘клавиатуру’. Альтернативно, выберите другую ноту или паузу того 
же значения и скопируйте ее, куда вы хотите ее отправить, Alt-щелчком. 
Если программа PhotoScore пропустила ноту/паузу при чтении музыки, она просто оставит промежуток. Можно 
исправить это простым копированием ноты/паузы в этот промежуток. 
Если вы хотите быстро добавить ноту к существующему аккорду, выберите аккорд и затем дважды щелкните 
там, где вы хотели бы добавить новую ноту. 
 
 



Удаление нот/пауз 
PhotoScore может иногда принимать некоторую другую пометку за ноту или паузу, оставляя вас с лишней нотой 
или паузой в такте. Для удаления ноты/паузы, просто выберите ее и нажмите Delete. Можно выбрать 
несколько нот/пауз для удаления путем перетаскивания рамки выделения вокруг них, а затем нажать Delete. 
Поскольку PhotoScore не пытается ‘расширить’ такты паузами, то удаление ноты просто удаляет ее вместо того, 
чтобы превратить ее в паузу. Вы можете явно превратить ноту в паузу при помощи ‘клавиатуры’, если вам 
нравится. 
Пользователи Sibelius  
В отличие от Sibelius, удаление паузы не оставит невидимую паузу на ее месте, так что вы не должны 
беспокоиться об оставленных невидимых паузах. 

Привязка 
Подобно тому как текущий нотоносец подсвечивается белым, при создании или копировании пометки, так и 
нотоносец, к которому будет привязана пометка, выделен белым. 
Таким образом, при помещении ноты или другой пометки с одного на другой нотоносец, первым делом 
переместите мышь вверх или вниз, пока намеченный нотоносец не подсветится, затем щелкайте. 

Добавление тактовых черт 
Иногда такт ‘не складывается по сумме’, потому что PhotoScore пропустил тактовую черту, таким образом 
произведя такт двойной длины. Чтобы исправить это, просто выберите тактовую черту откуда-либо на странице 
и скопируйте ее в разрыв, где тактовая черта должна быть, Alt-щелчком. Альтернативно, вы можете выполнить 
щелчок правой кнопкой и выбрать тактовую черту из меню, которое появится. 

Два или больше голосов 
Когда музыка изложена двумя или больше голосами, PhotoScore помечает каждую ноту/аккорд/паузу 
соответствующим цветом (синий, зеленый, оранжевый или фиолетовый для голосов с 1 по 4). В примере ниже, 
верхние ноты окрашены в синий (голос 1), а нижние окрашены в зеленый (голос 2). 

 
Для изменения голосовой принадлежности выбранной ноты/аккорда/паузы, нажмите Alt+1 для помещения 
ее/его в первый голос, Alt+2 для помещения ее/его во второй голос, Alt+3 для третьего голоса или Alt+4 для 
четвертого голоса. Альтернативно, вы можете использовать ‘клавиатуру’. 
PhotoScore показывает ошибки ритма для каждого голоса независимо в соответствующем голосу цвете в конце 
такта. Позаботьтесь при исправлении любых ошибок ритма, чтобы все голоса обретали корректное количество 
тактовых долей в такте. 
Общий источник ошибок ритма: просто одна или более нот находятся в неправильном голосе. PhotoScore может 
предположить, что такт со штилями и вверх и вниз изложен двумя голосами, когда на самом деле - только одним. 
Вы можете исправить это путем перетаскивания рамки выделения над всеми нотами, выделив их таким 
образом, затем введя Alt-1 для помещения нот в единственный голос. 

Форшлаги и ноты мелкого раштра 
Программа PhotoScore будет часто правильно распознавать форшлаги; однако, она предполагает, что они – 
ноты мелкого раштра, и будет поэтому включать их в ритм такта. 
Из-за этого вам рекомендуется удалить любые форшлаги и повторно ввести их в отдельной музыкальной 
программе; иначе такты с форшлагами получатся с неправильным количеством тактовых долей. 
Ноты мелкого раштра, однако, вполне ‘стыкуются’ с ритмом в такте, таким образом, можно оставить их внутри. 

Советы по редактированию 
Если вы делаете ошибку (например, удалив не ту пометку), можно 'отменить' это действие нажатием Ctrl+Z. 
Можно инвертировать отмену (UnDo), это называется 'восстановление' (ReDo), нажатием Ctrl+Y. Программа 
PhotoScore помнит, и таким образом можно отменить, до сотни последних выполненных действий 
редактирования. 
Когда вы приобретете опыт с редактированием ритмов, можно сэкономить время, не озабочиваясь заполнять 
любые паузы, которые могут отсутствовать в концах тактов. 
Это вызвано тем, что когда сохраняется файл MIDI, или партитура отправляется в Sibelius, любые такты, 
которые слишком коротки (согласно преобладающему метрическому размеру), будут автоматически расширены 



для вас паузами. 
Если вы обрабатываете программой PhotoScore длинную партитуру, то рекомендуется из соображений 
безопасности, чтобы вы сохраняли свою партитуру на диск после редактирования каждой страницы. 
 Приведенная в конце Руководства сводка клавиш быстрого вызова поможет существенно ускорить 
работу по редактированию распознанной партитуры. 
 
 

РЕДАКТИРОВАНИЕ ДРУГИХ ПОМЕТОК 
Как отмечалось ранее; вы, возможно, захотите отредактировать другие пометки в другой музыкальной 
программе, а не в PhotoScore, особенно пока всё ещё учитесь использовать PhotoScore. Поэтому, если хотите, 
можете пока что пропустить этот раздел. 

Копирование пометок 
Для копирования пометки просто выберите ее, укажите на другое место и щелкните с нажатым Alt. Можно 
скопировать почти любой тип пометки. 

Удаление пометок 
Для удаления любой пометки просто выберите ее и нажмите Delete. Держите нажатым Ctrl при удалении 
знаков ключа (тональности) для удаления всех их из системы. 

Знаки альтерации и знаки артикуляции 
Они могут быть применены к выбранной ноте с помощью ‘клавиатуры’. 

Тактовые черты 
Вы можете исправить неправильно распознанную тактовую черту двойным щелчком - или щелчком правой 
кнопки мыши по нему и выбором корректной тактовой черты из меню, которое появляется. Можно создать 
специальные тактовые черты из меню Create {Создать}. 

Ребра (Вязки) 
Можно изменить группировку нот ребрами с помощью ‘клавиатуры’. 

Ключи 
В целом не предполагается, что инструмент сохраняет тот же ключ всюду по партитуре, таким образом, ключ в 
начале нотоносца может быть неправильным, даже если он был корректным в предыдущем нотоносце. Если так 
происходит, это легко исправимо просто двойным щелчком или щелчком правой кнопки по дефектному ключу и 
выбором корректного из диалогового окна, которое появляется. Исправление ключа на ключ ударных исправит 
каждый ключ на высвечиваемой в данное время странице для этого инструмента. К диалоговому окну Clef 

{Ключ} можно также получить доступ из меню Create {Создать}. 
Чтобы вставить изменение ключа в середине нотоносца, можно выбрать и скопировать желаемый ключ и 
вставить его там, где вы хотите изменить ключ. Программа PhotoScore автоматически нарисует его в меньшем 
размере. 
Если вы переписываете музыку для инструмента, который использует иной ключ, пометьте ‘галочкой’ Rewrite 

notes {Переписать ноты} в диалоговом окне Clef {Ключ}, чтобы изменить все ключи для этого инструмента 
и скорректировать положения всех нот на его нотоносцах соответственно. 

Знаки Кода и Сэньо (не Облегченная версия) 

Вы можете создать знаки Кода и Сэньо из подменю Create> Symbol {Создать> Символ}. Если нота или пауза 
еще не выбраны, нужно теперь нажать на ноту или паузу для помещения знака. Тогда появляется диалоговое 
окно, и надо ввести любой текст, который будет связан со знаком кода или сэньо, и нажать "OK". Оставьте 
текст незаполненным для создания одного только знака. 
Чтобы отредактировать текст существующего знака кода или сэньо, сделайте двойной щелчок или щелчок 
правой кнопкой по нему так, чтобы появилось то же диалоговое окно, которое используется при создании знака 
кода или сэньо. Введите текст и нажмите "OK". 
Когда знак кода или сэньо выбран (и Attachment {Привязка} отмечена в меню View {Вид}), то проводится 
пунктирная линия между знаком кода или сэньо и нотой, к которой он привязан. PhotoScore автоматически 
повторно привязывает знаки кода и сэньо к ближайшей ноте, когда они добавляются, перетаскиваются или 
когда нота удалена. 
Возможно создать промежуток в системе (для пометки отдельного раздела коды) путем добавления тактовой 
черты коды из меню Create> Barline {Создать> Тактовая черта}. Промежуток будет после предыдущей 
тактовой черты. 
 



Ноты-перебежчики (не Облегченная версия) 

Чтобы переместить ноту на нотоносец выше или ниже, при сохранении ее как части ритмического размера ее 
текущего нотоносца, выберите ее и изберите одну из опций в подменю Notes> Cross-Staff Notes {Ноты> 

Ноты-перебежчики}. 
Поскольку нотоносец, на который она перемещена, не содержит синхронизации ритма для этой ноты (она 
остается частью исходного нотоносца), вам, возможно, придется добавить невидимые паузы, чтобы обеспечить 
в такте правильную сумму ритмических долей (невидимые паузы ‘расширяют’ длительность такта, но не 
печатаются). Чтобы сделать это, вставьте паузу в соответствующей позиции. Затем выберите ее и пометьте 
Notes> Hide или Show Rests {Ноты> Показать/скрыть паузы} так, чтобы она стала серой, показывая, что 
она невидима. 

Аппликатура (не Облегченная версия) 

Можно создать нотную аппликатуру из подменю Create> Text {Создать> Текст}. 
Появится диалоговое окно, позволяющее вам ввести до пяти значений аппликатуры из выпадающих списков. 
Нажмите "OK" для помещения пометки в партитуру. Если нота еще не выбрана, нужно нажать на ноту для 
помещения пометки. Положение этой пометки может быть изменено посредством щелчка по ней и 
перетаскивания мышью, и может быть отредактирована двойным щелчком или щелчком правой кнопки по ней. 

Схемы гитарных аккордов и Обозначения гитарных аккордов (не Облегченная версия) 

Вы можете создавать схемы (диаграммы) гитарных аккордов и обозначения (символы) гитарных аккордов из 
меню Create {Создать} и подменю Create> Text {Создать> Текст}. 
Появляется диалоговое окно, позволяющее вам добавлять/редактировать текст обозначения аккорда в верхней 
половине и схему (диаграмму) в нижней половине. Обратите внимание, что PhotoScore не синхронизирует 
обозначение и схему, таким образом, возможно создать комбинацию схемы и обозначения, которая не имеет 
смысла. 
Если помечено Show chord symbol {Показать обозначение аккорда}, то можно выбрать компоненты 
аккорда, тип и бас обозначения из выпадающих меню. 
Если помечено Show chord diagram {Показать схему аккорда}, то можно кликнуть на соответствующих 
струнах и ладах в схеме для добавления пометок положения пальцев. Щелкните наверху струны для 
переключения между открытой струной и «молчащей». Щелкните по стрелкам справа схемы для корректировки 
начального лада (fret=лад). 

     
Нажмите "OK" для помещения пометки в партитуру. Если нота или пауза еще не выбраны, вам надо теперь 
нажать на ноту или паузу для помещения туда пометки. Местоположение этой пометки может быть изменено 
посредством щелчка по ней и перетаскивания мышью, и пометка может быть отредактирована двойным 
щелчком или щелчком правой кнопки по ней. 

Названия инструментов 
Если названия инструментов нотоносцев в каждой системе не написаны или не были считаны правильно, вы 
можете и должны отредактировать их на названия фактических инструментов, используемых в партитуре: 
1 Найдите область слева от любых нотоносцев, где должно быть написано название инструмента, и 
сделайте двойной щелчок для открытия диалогового окна. 
2 Пройдите по каждому инструменту в списке, выберите его, щелкните по Rename… 

{Переименовать…} и изберите новое название из списка стандартных инструментов, или введите его вручную. 
Если некоторые системы в оригинале имеют пропускаемые нотоносцы, или если новые инструменты или 
нотоносцы представлены не с самого начала (например, где струнные разделяются), смотрите Расширенные 

функции. 

Мультипаузы 
Вы можете создавать мультипаузы из подменю Create> Bar Rest {Создать> Тактовая пауза}. Выберите 



число тактов, на которые вы хотите, чтобы мультипауза продлилась, и нажмите "OK" для помещения пометки. 
Перетащите ее горизонтально для корректировки ее  размера. 

Мелизмы (не Облегченная версия) 

Вы можете создавать мелизмы (трели, морденты и группетто) из подменю Create> Symbol {Создать> 

Символ}. Если нота или пауза еще не выбраны, то вам надо теперь щелкнуть на ноте или паузе для помещения 
пометки. Местоположение этой пометки может быть изменено посредством щелчка по ней и перетаскивания 
мышью, и пометка может быть отредактирована двойным щелчком или щелчком правой кнопки по ней. 

Пометки педали (не Облегченная версия) 

Вы можете создавать пометки для педали нажать/отпустить из подменю Create> Symbol {Создать> 

Символ}. Если нота или пауза еще не выбраны, вам надо теперь щелкнуть на ноте или паузе для размещения 
пометки. Местоположение этой пометки может быть изменено посредством щелчка по ней и перетаскивания 
мышью, и пометка может быть отредактирована двойным щелчком или щелчком правой кнопки мыши по ней. 

Высота 
Вы можете исправлять высоты посредством перетаскивания нот вверх и вниз, или нажатием стрелок курсора 
вверх/вниз. Мы рекомендуем использовать клавиши со стрелками, если это возможно, поскольку мышью более 
трудно точно позиционировать ноты. 
Если у аккорда отсутствует нотная головка, выберите аккорд и сделайте двойной щелчок там, где вы хотите ее 
добавить. Альтернативно, выберите другую нотную головку в таком же аккорде и скопируйте ее Alt-щелчком 

туда, где вы хотите ее добавить. 
Обратите внимание, что вы не можете изменить вертикальную позицию пауз, но это - довольно редкое 
требование так или иначе. Можно всегда скорректировать их положение позже в другой музыкальной программе, 
при необходимости. 

Вольты (окончания реприз) (не Облегченная версия) 

Вы можете создавать вольты с помощью пункта меню Create> Line> Repeat Ending {Создать> Линия> 

Вольта}. Если нота или пауза еще не выбраны, то вам надо теперь щелкнуть на ноте или паузе для 
помещения ее. Тогда появляется диалоговое окно, и вам нужно ввести номер вольты и нажать "OK". 
Чтобы отредактировать номер вольты, сделайте на ней двойной щелчок или щелчок правой кнопкой, так чтобы 
появилось то же диалоговое окно, которое используется при создании вольты. Введите номер и нажмите "OK". 
Щелкните и перетащите левую сторону пометки вольты для перемещения ее в другой такт. Для редактирования 
количества тактов, которые она охватывает, переместите курсор вправо от ее левой стороны так, чтобы курсор 
стал горизонтальной линией со стрелками в каждом конце, и затем щелкните и перетащите влево или вправо. 

Фразировочные лиги / вилки (не Облегченная версия) / связующие лиги 
Делайте фразировочные лиги с помощью подменю Create> Line {Создать> Линия}. После выбора 
положения фразировочной лиги, если нота еще не выбрана, вам надо щелкнуть на ноте для размещения лиги. 
Выбор множественных нот в пассаже перед созданием фразировочной лиги повлечет создание лиги согласно 
продолжительности выбора. Начальная и конечная позиция фразировочной лиги могут быть скорректированы 
посредством щелчка вблизи концов лиги и перетаскивания мышью. Искривление может быть скорректировано 
щелчком и перетаскиванием вблизи центра фразировочной лиги. 
Делайте вилки (типа крещендо/диминуэндо) с помощью подменю Create> Line {Создать> Линия}. После 
выбора направления вилки, если нота еще не выбрана, вам надо щелкнуть на ноте для размещения вилки. 
Начальная и конечная позиция вилки могут быть скорректированы посредством щелчка вблизи концов вилки и 
перетаскивания мышью. 
Когда вилка выбрана (и Attachment {Привязка} отмечена в меню View {Вид}), пунктирная линия 
изображается между вилкой и нотой, к которой она привязана. PhotoScore автоматически повторно привязывает 
вилки к ближайшим нотам, когда они добавляются, перетаскиваются или когда нота удалена. 
Добавляйте/удаляйте связующие лиги посредством выбора соответствующей начальной ноты и использования 
‘ клавиатуры’. Искривление может быть скорректировано щелчком и перетаскиванием вблизи центра связующей 
лиги. 

Текст (Облегченная версия - только текст темпа) 

Вы можете создавать текст из меню Create {Создать}. Верхняя часть подменю Text {Текст} содержит типы 
текстов, которые могут быть привязаны к нотам или паузам (текст нотоносца). Нижняя половина содержит 
типы, которые могут быть привязаны непосредственно к странице (текст страницы). Выберите тип текста, 
который будет размещен. Если вы добавляете текст нотоносца, и нота или пауза еще не выбрана, вам надо 
теперь щелкнуть на ноте или паузе для размещения текста. Тогда появляется диалоговое окно, в котором 
можно ввести текст. 



Чтобы отредактировать существующий текст, сделайте двойной щелчок или щелчок правой кнопкой по нему, так 
чтобы появилось диалоговое окно. Верхняя его часть позволяет вам изменять стиль текста (между, допустим, 
Lyrics {Стихи} и Expression {Нюансировка}). Средняя часть позволяет вам редактировать сам текст, и нижняя 
часть показывает вам, какой эффект этот текст будет иметь при сохранении в файлы MIDI и воспроизведении. 
Если вы хотели бы, чтобы текст содержал символ ноты (например, для метки метронома), нажмите одну из 
кнопок следом за Symbols: {Символы:}. Также возможно выбрать, должен ли текст быть полужирным, 
курсивом, подчеркнутым или скрытым (скрытый текст выводится на экран серым и не появляется в 
распечатках). Затем нажмите "OK". 
Если вы хотите отредактировать много вхождений одного и того же текста, можно выбрать Edit> Find and 

Replace …{Правка > Поиск и замена} или вводить Ctrl+F (не Облегченная версия). Под запросом Find 

what {Что требуется найти}, в диалоговом окне, которое появляется, введите текст, который PhotoScore 
должна искать и, при необходимости, выберите определенный стиль (например, Стихи) из выпадающего меню. 
Если вы хотели бы, чтобы PhotoScore искала только текст, записанный в том же регистре или только для слов 
целиком, пометьте Match case {С учетом регистра} или Find whole words only {Только слово целиком}. 
Под запросом Replace with {Заменить на} введите текст замены и выберите стиль замены или выберите 
Keep existing {Сохранить существующий}. Затем нажмите Find next {Искать далее} для поиска каждого 
вхождения ошибки, Replace {Заменить} для исправления выбранной сейчас или Replace all {Заменить все} 

для замены каждого из вхождений сразу. 
Когда текст, который привязан к нотам или паузам, выбран (и Attachment {Привязка} помечена в меню View 

{Вид}), пунктирная линия изображается между текстом и нотой, к которой он привязан. PhotoScore 
автоматически повторно привязывает текст к ближайшей ноте, когда он добавлен, перетащен или когда нота 
удалена. 
Больше подробностей о считывании/распознавании текста может быть найдено в Расширенных функциях. 

Триоли и туплеты (Облегченная версия - только триоли) 

Прежде чем создать туплет (триолеподобную фигуру), длительность первой ноты, которая будет включена в 
туплет, должна быть установлена равной единичной длине туплета. Например, единичной длиной триоля, 
продолжающегося длительность половинной ноты, является четвертная нота, а  единичной длиной дуоля, 
продолжающегося четвертную ноту с точкой, является одна восьмая нота. Если вы хотите, чтобы длительность 
первой ноты отличалась от единичной длины, вам нужно изменить ее длину после того, как туплет был создан. 
Чтобы создать туплет, или 
1) Нажмите на первую ноту, включаемую в туплет, и введите Ctrl+n, где n является числом, выводимым 
над нотами, или 
2) Выберите Tuplet {Туплет} из меню Create {Создать}. Можно тогда или ввести единственный номер, 
или пропорцию (отношение) в форме n:p, где n нот играются во время p нот. Можно также выбрать, должна ли 
квадратная скобка выводиться на экран, плюс скорректировать квадратные скобки на всех туплетах в партитуре 
и в будущих партитурах. В окне вывода, если отношение туплета не является 'стандартным', то отношение 
будет записано вместо одиночного числа. 
Также возможно щелкнуть и перетащить туплеты для изменения их вертикального положения. 

 

 

 ЧТЕНИЕ/РАСПОЗНАВАНИЕ РУКОПИСНОЙ МУЗЫКИ 
 (Только Полная версия) 
В этой главе описывается распознавание программой PhotoScore рукописной музыки для партитур, которые 
были отсканированы в ней. Если вы предпочитаете написать от руки музыку на устройстве с сенсорным 
экраном, применяя стилус или палец, то обратитесь к руководству пользователя NotateMe, которое может быть 
открыто из Меню Help {Справка}. 
Поддерживается широкий спектр стилей почерка, и нет никакой необходимости описывать для PhotoScore стиль 
почерка перед сканированием. Как только вы закончили редактирование выходной партитуры, быстро и легко 
переформатируйте ее для публикации, используя функцию Rescore {Переработка оркестровки} 

программы PhotoScore (см. Reformatting and extracting parts {Переформатирование и извлечение партий} 
в главе ПОСЛЕ ВЫПОЛНЕНИЯ PHOTOSCORE. 
Важно: Убедитесь, что Read as Handwritten Music {Читать как Рукописную Музыку} выбрано в Панели 
страниц (см. главу 2. РАСПОЗНАВАНИЕ(ЧТЕНИЕ)) или в Установках PhotoScore (см. главу РАСШИРЕННЫЕ 
ФУНКЦИИ). 



Возможности 
В настоящее время программа PhotoScore способна считывать/распознавать следующие рукописные 
музыкальные символы: 

 Ноты и аккорды (включая направление штилей, ребра и флажки) 

 Паузы, точки увеличения (одиночные и двойные) 

 Диезы, бемоли и бекары 

 Ключевые знаки 

 Фразировочные лиги и связующие лиги 

 Тактовые черты, 5-линеечные нотоносцы, системы нотоносцев 

 Формат страницы, включая размер страницы, размер нотоносца, поля, и окончания системы 
Ключи и метрические размеры не считываются, но вычисляются по музыке и автоматически добавляются 
программой PhotoScore. Системы нотоносцев могут быть считаны, если соединительная тактовая черта в 
начале каждой строки музыки была нарисована. Туплеты/триоли не считываются, но вычисляются от музыки и 
автоматически добавляются программой PhotoScore. Они также могут быть вручную добавлены после того, как 
партитура была считана/распознана (см. главу 3. РЕДАКТИРОВАНИЕ). 

Сканирование 
Лучшие результаты получаются из четкого, хорошо контрастного, 8-битного «в оттенках серого» скана. Если вы 
находите, что страница, когда-то отсканированная в PhotoScore, кажется чрезмерно черной или неясной, или что 
линии являются тонкими и прерывистыми, то можно попытаться сканировать в 1-битном черно-белом и вручную 
скорректировать для вашего сканера установки яркости, контрастности и черные-к-белому пороговые настройки. 
Мы рекомендуем вам сканировать в разрешении 300 точек на дюйм. Как только вы приобретете опыт работы с 
PhotoScore, вы сможете найти лучшие результаты в других разрешениях, но для большей части музыки 300 
точек на дюйм идеальны. 

 

 

 

 ПОСЛЕ ВЫПОЛНЕНИЯ PHOTOSCORE 
Как только вы отсканировали партитуру программой, и страницы были считаны и отредактированы, вы можете 
переформатировать ее, извлечь партии, транспонировать, распечатать, воспроизвести и/или сохранить музыку 
для использования в других музыкальных программах. Кроме того, можно отправить музыку непосредственно в 
Sibelius [пока нельзя !] и даже создать файлы, подходящие для записи на аудио-CD. 

Переформатирование и извлечение партий (не Облегченная версия)  

Важно: Все ошибки ритма должны быть исправлены перед использованием любой из этих функций (для 
получения инструкций, как сделать это, смотрите Редактирование ритма и ключевых знаков в главе 3. 
РЕДАКТИРОВАНИЕ). Мы также рекомендуем исправить любые другие ошибки сначала, поскольку эти функции 
создают новую партитуру, которая не привязана к страницам, с которых она была первоначально отсканирована. 
При создании выходной партитуры PhotoScore автоматически придерживается формата отсканированных 
страниц. Если исходная партитура имела плохую разбивку (например, с нотами или нотоносцами, сдавленными 
вместе), или была записана вручную, то вы можете быстро улучшить форматирование посредством выбора 
Notes> Rescore … {Ноты> Переработка оркестровки} и нажатия "ОК" в диалоговом окне Rescore 

{Редактирование оркестровки}, которое появится. Вам тогда предоставится возможность сохранить 
партитуру с ее оригинальным форматированием (если необходимо), прежде чем вновь отформатированная 
копия будет создана. 
Если вы хотите переформатировать партитуру для иного размера страницы или изменить ее ориентацию с 
портретной на ландшафтную [книжная/альбомная] или наоборот, то выберите из опций под запросом Page size 

{Размер страницы} перед нажатием "ОК". 
Диалоговое окно Rescore {Редактирование оркестровки} может также использоваться для удаления 
инструментальных или вокальных партий из партитуры. Это полезно, когда необходимо создать сольные партии 
из полной партитуры. Также, вы можете захотеть, чтобы PhotoScore обеспечила аккомпанемент (см. Playing 
{Играть/Воспроизведение} ниже), пока вы практикуетесь в собственной партии. 
Для удаления одного или более нотоносцев из партитуры, щелкните на их названия в списке Staves and 

voices to include {Включаемые нотоносцы и голоса} так, чтобы они больше не были выбраны и 
выделены синим. Нажмите на название нотоносца снова для включения его еще раз. После нажатия "ОК" вам 



предоставится возможность сохранить полную партитуру (если необходимо). Затем PhotoScore создаст новую 
партитуру, автоматически переформатированную для удаления любых разрывов, оставленных удаленными 
нотоносцами. 
Также возможно удалить голоса из одного или более нотоносцев. Чтобы сделать это, нажмите на номере 
каждого голоса следом за именем нотоносца, в котором он находится. Щелкните в том же месте снова для 
включения его обратно. 
Если требуется сменить вертикальное положение нотоносца в партитуре (например, если вы изменили 
инструмент, которым он должен исполняться), используйте клавиши Стрелки Вверх и Вниз для изменения, 
какой нотоносец в списке выделен точечным контуром. Затем используйте кнопки-стрелки с левой стороны 
диалогового окна для продвижения этого нотоносца вверх или вниз. Альтернативно, щелкните на имени 
нотоносца, чтобы выделить его точечным контуром, измените положение нотоносца кнопками-стрелками и 
затем щелкните на его имени снова для выбора его. 

Транспонирование 
Чтобы транспонировать партитуру или отдельный инструмент, например, перенести его в диапазон, более 
легкий для игры или пения, выберите Notes> Transpose … {Ноты> Транспозиция…}. 
Сначала выберите Whole Score {Партитура целиком} или инструмент, который вы хотите транспонировать, 
из верхнего поля. Затем установите интервал, на который вы хотите транспонировать, щелкнув по Up или 
Down {Выше или Ниже}, и затем выбрав основной интервал из поля справа. 
В поле слева, Major/Perfect {Большая/Чистая} оставляет основной интервал неизменным, Augmented 

{Увеличенная} добавляет полутон, Minor/Diminished {Малая/Уменьшенная}, вычитает полутон. 
Пометьте Transpose key signatures {Транспонировать ключи тональности}, если вы хотите, чтобы ключи 
тональности были транспонированы. Это обычно имеет эффект сокращения количества знаков альтерации, 
добавленных к нотам. (Если опцию выключить, транспонированные ноты принимают знаки альтерации, которые 
в ином случае стояли бы при ключе.) 

Печать (не Облегченная версия) 

Вы можете распечатать одну или более страниц вывода посредством выбора File> Print … {Файл> Печать…}. 
Вам предоставят стандартное диалоговое окно печати Windows, которое следует использовать обычным 
способом. 

Играть/Воспроизведение 
Вы можете воспроизводить музыку, полученную в результате работы программы PhotoScore. Ваш компьютер 
должен иметь MIDI-устройство (компонент большинства современных звуковых карт) и соответствующие 
установленные драйверы, для использования этой функции. 
Выведите на экран страницу, где вы хотели бы, чтобы воспроизведение началось. Для игры с начала страницы 
убедитесь, что ничего не выбрано, щелчком на области страницы без нотации, или нажатием Escape. Затем 
щелкните по зеленой треугольной кнопке воспроизведения в верхнем левом углу выходной партитуры или 
выберите Play/Pause {Играть/Пауза} из меню Play {Играть} или нажмите Пробел. Сделайте то же снова 
для приостановки воспроизведения (кнопка воспроизведения станет кнопкой паузы), и еще раз для 
возобновления. Щелкните на квадратной синей кнопке Стоп справа от кнопки воспроизведения или выберите 
Play> Stop {Играть/ Остановить} или нажмите Escape для остановки музыки в целом. 
В то время как музыка играет, текущий играемый такт будет выделен темно-серым. PhotoScore будет выводить 
на экран последовательные страницы по мере их проигрывания. Когда воспроизведение приостановлено, такт, 
которого достигла PhotoScore, останется выделенным. 
Для воспроизведения с конкретной позиции на странице, выберите ноту или паузу в такте, с которого вы хотели 
бы начать воспроизведение. PhotoScore тогда начнет с начала этого такта. Для воспроизведения одного или 
более инструментов без остальных, снимите флажок Always play whole system {Проигрывать всю систему 

нот полностью} в Установках PhotoScore Advanced {Дополнительно} (см. Настройки PhotoScore в главе 
РАСШИРЕННЫЕ ФУНКЦИИ), и выберите нотацию в каждом нотоносце, принадлежащем этим инструментам. 
Воспроизведение начнется с начала первого такта, содержащего выбор. 
В тех же Установках пометьте Ignore repeats and multirests {Игнорировать репризы и мультипаузы}, 
если вы хотели бы, чтобы PhotoScore проигнорировала все знаки повтора во время воспроизведения. 
В зависимости от установок Espressivo, Swing и Reverb {Экспрессия, Свинг и Реверберация} под меню 

Play {Играть}, воспроизведение будет немного варьироваться (не Облегченная версия). Обратитесь к их 

описаниям в Saving MIDI files {Сохранение файлов MIDI} далее в этой главе. 
Чтобы придать нотоносцу звучание другого инструмента, поменяйте его название посредством двойного щелчка 
слева от него и выбора Rename … {Переименовать…} из диалогового окна. 



Чтобы изменить темп или динамику, добавьте текст Tempo or Expression {Темп или Нюансировка} из 
меню Create {Создать> Текст} к той ноте в партитуре, где вы хотели бы начать эффект (см. Text {Текст} в 
главе 3. РЕДАКТИРОВАНИЕ). Если бы PhotoScore не смогла найти пометку темпа во время считывания, она 
автоматически добавит пометку красным цветом в начале партитуры. Сделайте двойной щелчок или щелчок 
правой кнопкой по ней для изменения ее на желаемый темп. 
Примечание: Если у вас более чем одно MIDI-устройство, то будет использоваться устройство по умолчанию, 
но это может быть изменено в Панели Управления Windows. PhotoScore предлагает кнопку System Playback 

Properties… {Системные настройки воспроизведения …}  в панели Advanced {Дополнительно} 

диалогового окна Preferences {Установки}. 

Сохранение 
Если PhotoScore установлена считывать страницы автоматически после сканирования/открытия или если один 
или несколько файлов открыты путем перетаскивания их на ярлык PhotoScore, то каждая новая партитура 
сохраняется автоматически. Редактирования, впоследствии сделанные в партитуре, также сохраняются 
автоматически. 
Для сохранения автоматически сохраняемой партитуры в местоположении по вашему выбору, нажмите File> 

Save As … {Файл> Сохранить как…} (см. Сохранение файлов PhotoScore (.opt) ниже). После выполнения 
этого дальнейшие редактирования больше не будут сохраняться автоматически, но могут быть сохранены 
нажатием кнопки Save Score {Сохранить партитуру} вверху окна вывода. 
Вы можете также выбрать различные типы файлов /форматы для сохранения партитуры, путем выбора из 
всплывающего меню/ комбинированного окна внизу диалогового окна File> Save As… {Файл> Сохранить как…}. 
Обратите внимание, что некоторые форматы хранят меньше информации об отсканированной партитуре, чем 
другие (например, MIDI не хранит специфическую информацию о фразировочных лигах, знаках артикуляции, 
штилях ноты или о направлении лучей). Также обратите внимание, что не все музыкальные программы в 
состоянии открыть все перечисленные форматы файлов. 
После сохранения в файл, вы можете запустить любимую музыкальную программу, загрузить музыку, 
распознанную программой PhotoScore, и использовать ее как любую другую. 
Пользователи Sibelius  
Чтобы отправить вашу партитуру в Sibelius, просто щелкните по кнопке Send to Sibelius {Отправить в Sibelius} 
следом за Save As… {Сохранить как…} вверху окна вывода, для запуска Sibelius. В Sibelius откроется 
диалоговое окно, предлагающее вам выбрать инструменты (только Sibelius v3 и выше) и размер страницы. 
После одной-двух секунд, музыка появится в другом окне как документ Sibelius. 
Как только музыка оказалась в Sibelius, вы можете делать с ней всё что угодно, так же как если бы вы ввели ее 
сами. 
Примечание: Версии Sibelius более ранние, чем v5, не могут импортировать всю музыкальную информацию из 
файлов PhotoScore 7/8. Вот сводная таблица (детали, перечисленные в следующих одна за другой версиях, не 
повторяются): 
• v1 и v2 не могут считать файлы, произведенные PhotoScore 7 - необходимо использовать более раннюю версию 
PhotoScore. 
• v3.0 до v3.x не будут считывать нотоносцы ударных или партитуры, содержащие более 2 голосов. Более 
поздние версии импортируют файлы более точно. 
• v4.0 до v4.x не будут считывать знаки коды, знаки сэньо, мелизмы, пометки педали, вольты, ферматы на паузах 
или нотах-перебежчиках. 

Сохранение файлов PhotoScore (.opt) 
Собственный формат файла PhotoScore (разработанный, чтобы хранить всю отсканированную информацию 
нотации) имеет расширение файла Windows .opt. 
В настоящее время только PhotoScore и Sibelius могут читать этот формат. Рекомендуется регулярно сохранять 
длинные произведения в этом формате на досадный случай программной ошибки или сбоя питания. 
Вы можете открыть файл PhotoScore в программе PhotoScore при помощи диалогового окна File> Open 

{Файл> Открыть}. 
 
Пользователи Sibelius  
Отсканированные музыкальные файлы могут быть импортированы в Sibelius путем открытия их из стандартного 
диалогового окна Open {Открыть}.  
Если у вас установлена версия Sibelius 3 или 4 (версии 1 и 2 не будут работать с PhotoScore 7), вы можете 
обнаружить, что он отказывается открывать файлы, сделанные в PhotoScore 7/8. В этом случае вам следует 



найти дополнительный тип файла в выпадающем меню типов/форматов, который позволит сохранить файлы 
PhotoScore в более старый формат, который смогут открыть эти версии Sibelius.  

Сохранение файлов MusicXML & NIFF 
Сохраняйте файлы MusicXML и NIFF, если вы хотите открыть вывод программы PhotoScore в программе нотации 
иной чем Sibelius, например, Finale. Finale 2006 может открыть файлы MusicXML из меню File. В Finale 2003 - 
2005 используйте ‘плагин ‘Dolet Light’ для открытия файлов MusicXML. 
Проверьте на веб-странице www.neuratron.com/fileformats.htm свежую информацию, в том числе какие программы 
открывают эти форматы файлов. 

Сохранение файлов PDF 
Сохраняйте PDF-копии своих партитур, чтобы поделиться ими с другими людьми, которые не владеют 
музыкальной программой нотации, или просмотреть их на других компьютерах и мобильных устройствах, на 
которых не установлено программное обеспечение музыкальной нотации. 

Сохранение файлов MIDI 
Файлы MIDI были разработаны, чтобы хранить музыкальную информацию о воспроизведении, в 
противоположность печатной нотации, и в результате имеют несколько ограничений, когда дело доходит до 
хранения отсканированной музыки. Однако они все еще очень полезны, поскольку практически каждая 
программа редактирования музыки может считывать этот тип файла. 
Две опции доступны, когда сохраняют файл MIDI: Когда Optimize for playback {Оптимизация для 

воспроизведения} помечено в диалоговом окне сохранения, то файл сохраняется с повторениями и 

нюансировкой, свингом или реверберацией, если выбраны для воспроизведения (не Облегченная версия). 
Пометьте Create a track for each voice {Создавать трек для каждого голоса}, если необходимо 

разделить голоса на различные дорожки MIDI (не Облегченная версия). 
Пожалуйста, следите за следующим, сохраняя файлы MIDI: 

 Если файл MIDI должен быть импортирован в программу музыкальной нотации, то Optimize for 

playback {Оптимизация для воспроизведения}, должен быть выключен для улучшения точности. Иначе это 
следует оставить, поскольку это улучшает реализм воспроизведения. 

 Штиль ноты и направление луча, конец нотоносца и расположение страницы, размер нотоносца и 
разделение на множество голосов на нотоносце не могут быть сохранены. Если файл должен оказаться в 
самостоятельной музыкальной программе, то конечные результаты зависят от того, как эта программа 
интерпретирует музыку. 

 Музыкальные особенности, такие как фразировочные лиги, изменения ключа, паузы, метки знака 
артикуляции, ноты с точкой, туплеты, динамика, пометки нюансировки и связующие лиги также не могут быть 
сохранены как объекты в файле MIDI. Однако, если они присутствуют, то PhotoScore будет эмулировать их для 
воспроизведения. Для ясности: Если файл MIDI воспроизводится из программы редактирования/ 
воспроизведения MIDI, то особенности будут услышаны, но особенности не обязательно будут присутствовать, 
если он открыт и выведен на экран в программе музыкальной нотации. 

 Несмотря на то, что особенности, такие как метрические размеры, ключевые знаки и текст (наподобие 
текста песни и заглавия, но не динамика, поскольку она используется для эмуляции изменений в громкости 
воспроизведения) сохраняются в файле MIDI, не все музыкальные программы будут обязательно использовать 
или отображать их. Вы можете обнаружить, что в вашей музыкальной программе существует опция, чтобы 
игнорировать или использовать такую информацию. 

 Инструменты, выделенные каждому нотоносцу, сохраняются согласно Общему стандарту General MIDI. 
Чтобы дать нотоносцу звук иного инструмента, поменяйте его название посредством двойного щелчка слева от 
него и выбора Rename … {Переименовать…} из диалогового окна. PhotoScore разумно выбирает корректный 
инструмент MIDI. 

 (не Облегченная версия), файл будет сохранен с нюансировкой (выразительностью) для более 
'человеческого' воспроизведения, в зависимости от текущего выбора из меню Espressivo {Экспрессия} (в 
соответствии с меню Play {Играть}). Существует пять различных степеней экспрессии для различных стилей 
музыки: 
Meccanico ('механически') играет партитуру абсолютно буквально, без динамики или знаков артикуляции, кроме 
явно отмеченных. 
Senza espress. ('без выражения'), добавляет только крошечные колебания громкости и небольшие акценты в 
начале тактов и групп нот, без полных динамических изменений. 
Poco espress. ('небольшое выражение'), имеет небольшую динамику, следуя контуру музыки. Подходящий для 
быстрого, довольно механического стиля (такого как Барочная музыка). 



Espressivo (‘выразительно’) является опцией по умолчанию с бОльшим количеством добавленной динамики. 
Molto espress. ('много выражения'), производит много выражения, которое может быть чрезмерно для 
некоторых видов музыки. Это работает хорошо на многочисленных группах инструментов, где это помогает 
разделить различные линии. 
Эти эффекты могут быть заметными, когда файл воспроизводится в программе редактирования/ 
воспроизведения MIDI. 

 (не Облегченная версия), Если выбрано из меню Play {Играть}, файл будет сохранен со свингом 
('колебанием') - джазовое соглашение, в котором две записанных нотами восьмых исполняются приблизительно 
как триоль четвертная нота плюс восьмая нота. Различные опции свинга таковы: 
Никакой - т.е. никакого свинга. 
Легкий / Стандарт / Тяжелый - от небольшого до почти триолей. 
Ноты Inégales (Неодинаковые ноты)- триоль четвертная нота плюс восьмая нота, используемые в некоторой 
старинной музыке. 
Восьмые с точкой - редко используемый. 

 (не Облегченная версия) Если выбрано из меню Play {Играть}, то реверберация (эффект, подобный 
эху, которое вы слышите в комнате) добавляется к воспроизведению. Она может быть установлена в различных 
предустановках между Dead {Сухой звук} и Cathedral {Собор}, или может быть введен процент. Обратите 
внимание, что эта функция будет работать только на устройствах, которые откликаются на и распознают 
сообщения реверберации стандарта General MIDI (GM). 

 (не Облегченная версия) PhotoScore также воспроизводит аподжатуры, или форшлаги. Поскольку они не 
соответствуют правильному метрическому счету такта, они играются до приблизительно половины обозначенной 
длительности, и ритмическая доля берется от следующей ноты. Если вы слышите странные эффекты или 
зависающие ноты, попытайтесь сократить ноты до восьмой или меньше. Если они воспроизводятся с нормальной 
длительностью ноты, то они, вероятно, являются нотами мелкого раштра; вы можете легко изменить их на 
аподжатуры с помощью ‘клавиатуры’ - см. главу 3. РЕДАКТИРОВАНИЕ. 

Сохранение файлов WAV (не Облегченная версия) 

 
Пользователи Windows  

 Эта функция требует Windows 98 или выше и полнодуплексную звуковую карту - большинство современных 
звуковых карт отвечают этому условию. DirectX 8.1 или свежее должен быть также установлен - последняя 
версия должна быть доступной с веб-сайта Microsoft.  

Сохраняйте файлы WAV, если вы хотите записать свою музыку на аудио-CD или преобразовать ее в формат 
MP3 (например, для воспроизведения на портативном проигрывателе цифровой музыки). Файлы Wave (с 
расширением файла .wav) хранят музыку похожим способом, как CD, и как таковые не сохраняют информацию 
относительно музыкальной структуры. Выгода в том, что эти файлы звучат одинаково (допуская различия среди 
динамиков и т.д.), независимо, от того, на каком программном обеспечении или аппаратных средствах они 
воспроизводятся. Качество вывода зависит от качества вашего MIDI-устройства - PhotoScore эффективно 
воспроизводит вашу отсканированную музыку как MIDI и записывает ее одновременно (даже если вы не можете 
услышать музыку). Сохранение файла Wave обычно занимает такое же количество времени, как 
воспроизведение всей партитуры средствами PhotoScore. 

Запись на аудио-CD (не Облегченная версия) 

Пользователи Windows  

 Возможно записать аудио-CD с помощью Windows Media Player, доступного от Microsoft. Следующие 
инструкции должны работать при использовании версии 12:  

 Нажмите на вкладку Запись на верхнем горизонтальном меню  

 Перетащите свои сохраненные Wave-файлы из Проводника на Список Записи с правой стороны окна.  

 Вставьте пустой CD-R или CD-RW в ваш записывающий CD-привод.  

 Нажмите Начать запись и ожидайте, пока создается ваш CD.  

 
Преобразование в MP3 (не Облегченная версия) 

Пользователи Windows  

 Если вы еще не обладаете внешним программным обеспечением для кодирования файлов MP3, мы 
рекомендуем использование LAME, свободного кодировщика MP3 с открытым исходным кодом, с сайта 
www.mp3-tech.org. Обратите внимание, что компания Neuratron не берет на себя ответственности за 



использование этого программного обеспечения или за какие-либо последствия, которые могут возникнуть в 
результате его использования.  

 

Сохранение файлов, содержащих ошибки ритма 
Если вы сохраняете файл, содержащий такты, которые ‘ не складываются’ по сумме ритмических долей, то 
такты, которые слишком коротки, будут удлинены, а те, которые слишком длинны, будут укорочены. 
Чтобы сделать это, длины тактов сравниваются с преобладающим метрическим размером. Если такт слишком 
короток, паузы просто вставляются в его конце. Если такт слишком длинен, он укорачивается путем исключения 
одной или более нот/пауз в конце такта. 
Несмотря на то, что длины тактов выравниваются описанным образом, вам настоятельно рекомендуется 
скорректировать неверные ритмы еще в PhotoScore, нежели чем пытаться исправить их уже потом в другой 
музыкальной программе, поскольку это избавит вас от дополнительной работы. 

Формат (Сохранение формата страницы и системы) 
Пользователи Sibelius  
Sibelius использует режимы Make Into System {Скомпоновать в систему} и Make Into Page {Скомпоновать в 
страницу} (подменю Layout> Format {Макет> Формат}), чтобы гарантировать, что формат музыки совпадает с 
оригиналом. Однако, если ноты кажутся неудобно близкими друг к другу или далекими друг от друга в конечном 
результате, попытайтесь изменить размер нотоносца в диалоговом окне Layout>Document Setup… {Макет> 
Настройки документа …} (сочетание клавиш Ctrl+D). Альтернативно, если вам не нужно, чтобы формат музыки 
соответствовал оригиналу, выберите всю партитуру (Ctrl+A) и разблокируйте формат (Ctrl+Shift+U). 

Сохранение инструментов, имеющих несколько нотоносцев 
Пользователи Sibelius  
PhotoScore рассматривает все нотоносцы как отдельные инструменты. Это означает, что инструменты, 
использующие по умолчанию два нотоносца (например, фортепиано), будут отправлены в Sibelius как два 
различных нотоносца с разными названиями и без акколады.  
Для многих целей вам не нужно, чтобы вообще появлялись названия инструментов, так что вы можете просто 
поменять настройку партитуры на House Style {Домашний Стиль} для отключения их.  
Альтернативно, если вы хотите заключить в фигурные скобки два нотоносца клавишных вместе и дать им общее 
название, то самый легкий способ сделать это - создать другой клавишный инструмент в Sibelius (например, 
Фортепьяно), скопировать музыку с клавишных без акколады на новый клавишный инструмент с акколадой 
(используя два прохода по нотоносцам), затем удалить клавишные без акколады.  
Та же процедура касается инструментов с несколькими нотоносцами, таких как Флейты 1+2, если вы хотите, 
чтобы они были записаны как два нотоносца под общей квадратной акколадой, с одним названием. 
Если ваш оригинал содержит инструменты, которые имеют разное количество нотоносцев в разных системах - 
например, струнные, которые иногда бывают divisi (разделяются) - смотрите Расширенные функции ниже. 

Сохранение файлов BMP и TIFF 
Вы можете хотеть сохранить исходную отсканированную страницу из PhotoScore, например, чтобы распечатать 
копии, или послать по электронной почте другому человеку для доказательства распознавания, наряду с 
выводом программы PhotoScore: 

 Если Панель страниц в настоящее время не видна, выберите View> Toggle Pages Pane {Вид> 

Показать/скрыть панель страниц}. 
 Переместите мышь на название той страницы в Панели страниц, которую вы хотите сохранить, так 
чтобы вы видели миниатюру страницы. 

 Щелкните на миниатюре или дважды-щелкните по названию страницы для отображения исходной 
страницы в окне справа. 

 Нажмите File> Save As … {Файл> Сохранить как…} и введите имя файла и путь, куда вы хотите 
сохранить, и также выберите, сохранить ли файл как TIFF или BMP из выпадающего меню Тип файла. 

 

 

ОЧИСТКА 

 
Пользователи Sibelius 
Как только вы закончили обработку музыкальной пьесы программой PhotoScore и отправили ее в Sibelius, вы 
имеете дело с файлом Sibelius, который нужно сохранить нормальным способом. 



После того, как вы отредактировали и сохранили выходную партитуру, она может быть закрыта, так чтобы вы 
смогли начать работу над новой партитурой. 
Обратите внимание, что возможно иметь только одну партитуру открытой в PhotoScore одновременно. 

Закрытие выходной партитуры 
Для закрытия выходной партитуры закройте окно вывода cтандартным образом, используя File> Close score 

{Файл> Закрыть партитуру} или путем нажатия кнопки с маленьким крестиком в правом верхнем углу. 
Если вы забываете закрыть выходную партитуру прежде, чем отсканировать следующую музыкальную пьесу, 
новые страницы, которые вы сканируете и считываете, будут добавлены в конец предыдущей выходной 
партитуры. Однако вы можете удалить старые страницы из выходной партитуры индивидуально, путем выбора 
Edit> Delete Page {Правка> Удалить страницу} из меню для каждой. 

Удаление нежелательных сканов 
PhotoScore автоматически сохраняет каждую страницу, которую вы сканируете. Это занимает весьма 
значительную сумму места на жестком диске, так что следует регулярно удалять сканы, которые были уже 
распознаны. Однако не нужно удалять сканы перед сканированием следующей музыкальной пьесы. 
Чтобы удалить нежелательные сканы: 

 Если область страниц в настоящее время не видна, выберите View> Toggle Pages Pane {Вид> 

Показать/скрыть панель страниц}. 
 Выберите страницы, которые вы хотите удалить, щелкнув на первой и затем выбирая дальнейшие с 
удержанием Ctrl (для добавления отдельных страниц) или Shift (для добавления ряда страниц) при щелчке. 

 Щелкните Remove {Удалить} на одной из выбранных страниц. PhotoScore тогда попросит вас 
подтвердить, что вы хотите удалить страницы. Если страница будет в области Read Pages {Распознанные 

партитуры}, в течение одной недели она все еще будет появляться, когда выходная партитура, к которой она 
привязана, будет открыта. Для удаления всех страниц, принадлежащих всей партитуре, нажмите Remove 

{Удалить} справа от имени партитуры в области Read Pages {Распознанные партитуры}. 

 

 

 

 ВОЗМОЖНЫЕ ПРОБЛЕМЫ 
Сканирование идет слишком долго или не работает 
 Если нет никаких признаков сканирования - т.е. если после нажатия на кнопку Scan {Сканировать} или 

Preview {Предварительный просмотр} сканер не движется, не светится и не мигает - возможно, нарушена 
связь между компьютером и сканером. 
Проверьте, что сканер включен и что его кабель верно подключен с обоих концов. Если это не помогло, 
попробуйте переустановить драйвер сканера TWAIN или WIA. 
Учтите, что некоторые модели сканеров нужно включать ДО включения компьютера, иначе компьютер их не 
находит. 

 Если PhotoScore отказывает при попытке сканировать, или отсканированная страница не выглядит 
правильной - Попытайтесь получить последнюю версию программного обеспечения драйвера сканера от дилера. 
Также, выберите интерфейс сканирования TWAIN из диалогового окна File> Scanner Setup… {Файл> 

Установки сканера …} и попробуйте еще раз. 

Не все нотоносцы/системы обнаружены 
Если после сканирования страницы вы обнаружите, что не все нотоносцы подсвечены синим, или что показано 
неправильное количество линий нотоносцев, или что нотоносцы неправильно объединились в системы по 
тонким красным вертикальным линиям, для этого могут быть следующие причины: 

 Исходный материал неплотно прилегал к стеклу сканера: Всегда закрывайте крышку при 
сканировании, кроме случаев сканирования толстой книги. Может помочь легкое надавливание на крышку 
сканера при сканировании. 

 Страница отсканировалась со слишком низким или слишком высоким разрешением (т.е. нотоносцы 
меньше, чем вы думаете): Проверьте размер нотоносца, измените соответственно настройки сканера и 
отсканируйте документ еще раз. 

 Вы пытались сканировать двухстраничный разворот: Программа PhotoScore не умеет сразу 
распознавать двухстраничный разворот (например, с очень маленькой партитуры). Отсканируйте еще раз каждую 
страницу отдельно. Убедитесь, что музыка с другого листа разворота не попадает на стекло и не сканируется 



(скорректируйте регион сканирования) – если часть ее попадет в скан, программа PhotoScore не сможет 
правильно распознать музыку. 

 Нотоносцы недостаточно четки в оригинале, чтобы быть обнаруженными: В этом случае можно 
указать программе PhotoScore, где любые недостающие нотоносцы расположены на странице – см. раздел 
Расширенные функции ниже. Альтернативно, можно идти дальше и распознать страницу, но музыка на любых 
необнаруженных нотоносцах будет проигнорирована. 

Чтение/распознавание идет слишком долго 
 Если у вас включено распознавание текста, то чтение займет больше времени. Может иногда оказаться 
быстрее распознать музыку, не обнаруживая текст, и повторно ввести его в отдельной музыкальной программе. 
Прервите распознавание, если необходимо (см. ниже), отключите опцию чтения текста, и затем считывайте 
снова. 

 Если сканируемая страница выгнута или крышка сканера не закрыта: у вас получится черная рамка 
вокруг страницы, которая может затемнить и часть музыкального произведения. При этом программа PhotoScore 
может очень долго пытаться распознать страницу. Если так получилось, прервите распознавание (см. ниже), а 
затем отсканируйте страницу заново. 

 Если после сканирования распознались не все нотоносцы (т.е. некоторые не выделены синим), это 
также может замедлять распознавание, см. Не все нотоносцы/системы обнаружены (выше). 

Музыка распознана неточно 
Если вы обнаружите, что музыка распозналась очень неточно, для этого могут быть следующие причины: 

 оригинал печатный, а в Панели страниц помечено Read as Handwritten music {Читать как 

Рукописную музыку}. 

 оригинал написан от руки, а в Панели страниц помечено Read as Printed music {Читать как 

печатную музыку}. 

 исходный материал очень низкого качества, например, плохая ксерокопия или старое издание; 

 музыка отсканирована в черно-белом режиме и слишком контрастна: рекомендуется сканировать в 
режиме градаций серого, если только это не заставляет скан выглядеть слишком зернистым или разъединенным; 

 музыка была отсканирована в слишком низком (меньше 200 точек на дюйм) или слишком высоком 
разрешении (больше 400 точек на дюйм). Попытайтесь увеличить или уменьшить разрешение, в котором 
сканируется страница; 

 сканируемая страница является слишком темной или светлой (когда просматривается в 100%, много 
символов зернисты и склеены с другими, или нотные штили и линии нотоносца разъединены). Попытайтесь 
сканировать, используя интерфейс TWAIN (выбирается из меню File> Scanner Setup… {Файл> Установки 

Сканера …}), и вручную настроить яркость; 

 оригинал не был достаточно ровным, когда сканировался, и Make scans level {Создать уровень 

сканирования}, не был выбран в диалоговом окне Preferences… {Установки…} программы PhotoScore 
(см. Расширенные функции ниже); 

 дизайн музыкальных символов в исходном материале выбран нестандартной формы или размера. 
Если PhotoScore неоднократно не удается считать одну страницу из последовательности страниц, пропустите 
страницу и введите такты в партитуру вручную с помощью отдельной музыкальной программы. 
 

Проблемы распознавания рукописного текста 
Если вы обнаружите, что PhotoScore перестала работать в целом, или почти полностью, даже на очень простой 
ясной рукописной музыке, проверьте следующее на основные проблемы: 

 Разрешение сканирования: Ваш сканер установлен сканировать на уровне 300 точек на дюйм? Это 
разрешение рекомендуется для рукописной музыки. В любом случае поэкспериментируйте с другими 
разрешениями для улучшения результатов, которые уже хороши, но 300 точек на дюйм являются обычно 
наилучшими. 

 Тип изображения: Удостоверьтесь, что ваш сканер установлен произвести изображение а режиме 
градаций серого. Это - тип, который PhotoScore предпочитает. 

 Качество изображения: Проверьте, что ваш скан является хорошим, чистым изображением, во всем 
ясным и четким, и без пятен. Также проверьте, что нет никаких изменений тона или отсутствующих областей 
изображения. 
 
 



Предупреждающие сообщения 
Большинство сообщений PhotoScore не требуют разъяснений: например, программа предупредит вас, если вы 
отсканируете в неподходящем разрешении, или если на вашем жестком диске исчерпано свободное 
пространство, и она будет обычно говорить вам, что делать дальше. 

Если все остальное перестало работать... 
Свяжитесь со своим поставщиком программы PhotoScore. 

 

 

 

 РАСШИРЕННЫЕ ФУНКЦИИ/ Дополнительные возможности 
В программе PhotoScore имеется множество дополнительных функций и опций для опытных пользователей. 
Настоятельно рекомендуется ознакомиться со всем содержимым этого раздела, прежде чем заниматься 
интенсивным сканированием, например, многостраничных партитур для оркестра или группы. 

Выбор между сканерами 
В случае, если у вас подключено к компьютеру несколько сканеров, вы можете выбрать один из них в меню File> 
Scanner Setup… {Файл> Установки Сканера …}. 

Сканирование только одной страницы 
Если вам нужно отсканировать только одну страницу в PhotoScore, нажмите Scan One Page … {Сканировать 

одну страницу} из меню File {Файл}. Это выполнит операцию сканирования как обычно, за исключением того, 
что PhotoScore не запросит новую страницу в конце сканирования. 

Настройка обнаруженных нотоносцев/систем 
При сканировании страницы программа PhotoScore выделяет нотоносцы, которые она обнаруживает, 
полужирными синими линиями (тонкими синими линиями, если она не уверена в точном количестве линий или 
позиции), и объединяет их в системы вертикальными полужирными красными линиями. Но при низком качестве 
исходного материала программа PhotoScore не может распознать некоторые из нотоносцев и систем, тогда вам 
нужно подсказать программе их расположение, иначе музыка не будет считана правильно. 
Самый простой способ сообщить PhotoScore положение нотоносца, который она потеряла, это выбрать 
ближайший подобный синий нотоносец (щелкнув по нему) и затем скопировать его Alt-щелчком по центральной 
линии пропавшего нотоносца (горизонтальное положение не важно). 
Также можно создать синий нотоносец с нуля, если щелкнуть (левой) кнопкой мыши и потащить ее по контуру 
нотоносца. 
После создания нотоносца, убедитесь, что он объединился со всеми другими нотоносцами в ту же систему (см. 
ниже). 
Программа PhotoScore автоматически обрежет нотоносец по месту перетаскивания, выравнивая его положение и 
размер, если найдет под ним соответствующий нотоносец. Она также повторно вычисляет количество 
существующих линий нотоносца, если только не удерживается нажатым Ctrl. Текст Aligned {Выровнен} 

появится в зеленом цвете под нотоносцем, и линии станут жирными, когда PhotoScore уверена в их положении. 
Чтобы сказать PhotoScore, что нотоносец содержит иное количество линий, выберите его и наберите 
корректное число между 1 и 6. 
Если выделенный нотоносец плохо расположен, или он недостаточно длинен, текст May Require Manual 

Adjustment {Возможно, требуется ручная регулировка} может быть выведен на экран ниже его, и вам 
необходимо использовать следующие инструкции для помощи PhotoScore: 

 Можно перетащить любой (синий) нотоносец вверх и вниз (левой) кнопкой мыши Ею же можно 
автоматически откадрировать нотоносец по месту. 

 Можно перетаскивать концы нотоносцев (края синей рамки) туда-сюда, и даже расположить их под 
углом. 

 Вы можете изменить высоту любого (синего) нотоносца - потяните за ‘ручки’ в средней части нотоносца 
вверх или вниз. Программа PhotoScore может распознавать страницы, имеющие нотоносцы различных размеров, 
каждый из (синих) нотоносцев может иметь свой размер. 

 Круглая ‘ручка’ сверху позволяет вам менять кривизну нотоносца. Это бывает полезно при 
сканировании толстых книг, где невозможно избежать кривизны страниц на краях. PhotoScore может не 
позволить вам делать это, если она уже очень уверена в положении нотоносца. 



Важно, чтобы нотоносцы соединились в системы правильно, поскольку это не может быть исправлено после 
распознавания. Если нотоносцы не соединились в системы правильно, используйте эти инструкции: 

 Для объединения двух смежных нотоносцев вместе в одну и ту же систему, щелкните по одному из 
нотоносцев (он станет красным), а затем сделайте Alt-щелчок по другому нотоносцу. . Они объединятся слева 
тонкой вертикальной (или почти вертикальной) красной линией. 

 Для разделения двух объединенных нотоносцев на две разных системы, повторите действия для их 
объединения. 
Программа PhotoScore автоматически делает предположения о том, какие из нотоносцев нужно объединять, а 
какие нет, при создании нового нотоносца или переносе существующего. 
Также проверьте, что нотоносцы отмечены корректным количеством линий нотоносца. PhotoScore 
считывает 1, 2, 3, 4, 5 и 6-линейные нотоносцы (только 5 и 6-линейные нотоносцы в Облегченной версии), и 
автоматически распознает тип существующих нотоносцев (например, нормальный, гитарная табулатура или 
ударные). Однако достаточно редко она обнаруживает неправильное количество линий, и нужно попытаться 
немного перетащить нотоносец туда-сюда, пока PhotoScore не распознает его правильно. 
Если какой-то из отсканированных нотоносцев остался без синей рамки сверху, то вся содержащаяся в нем 
музыка будет игнорироваться при распознавании страницы. При этом может замедлиться распознавание, но это 
не страшно. 
Если вы уже запутались в редактировании нотоносцев, можно 'отменить' (UnDo) действие нажатием Ctrl+Z. 
Можно инвертировать отмену (называется 'восстановление', ’ReDo’) нажатием Ctrl+Y. Если вы хотите начать с 
начала, то сделайте по скану Ctrl+двойной-щелчок, и PhotoScore сбросит синие выделенные нотоносцы к их 
исходным положениям. 

Опции окна сканирования 
Существуют различные дальнейшие опции и кнопки, доступные в окне сканирования: 

 Щелчок по кнопке Read this page {Читать эту страницу} запускает распознавание только 
высвеченного скана. Если нажать на часть кнопки со стрелкой, откроется меню, в котором можно выбрать, куда в 
выходной партитуре нужно поместить содержимое распознанной страницы. Страница перемещается в верхнюю 
часть списка ожидающих страниц в Панели страниц при считывании, чтобы гарантировать, что эта страница 
будет считана следующей. Это также временно отменяет любое другое происходящее считывание. 

 Кнопки-Стрелки выводят на экран предыдущую или следующую страницу в списке отсканированных 
страниц. 

 Значок лупы масштабирует страницу для заполнения всей ширины окна; 50 изменяет масштаб до 50%; 
100 изменяет масштаб до 100%. Смотрите меню View {Вид} насчет других способов масштабирования.   

 Повернуть на 180° быстро поворачивает страницу на 180 градусов, если она была отсканирована 

вверх ногами. 

 Повернуть по часовой стрелке поворачивает страницу на 90 градусов, если она была отсканирована 
боком. 

 Повернуть против часовой стрелки поворачивает страницу на 90 градусов против часовой стрелки, 
если она была отсканирована другим боком. 

 Пересканировать повторно сканирует страницу. 

Пропускаемые нотоносцы 
В партитурах для многих инструментов, в частности оркестровых, неиспользуемые нотоносцы часто 
пропускаются. 

 Если необходимо исправить распознанные названия инструментов в начале партитуры, то в 
последующих системах PhotoScore выделит инструменты нотоносцам в порядке сверху вниз. 
Следовательно, если на странице пропущен инструмент из одной системы, то в окне вывода некоторые 
нотоносцы могут иметь неправильные названия. 
В этой ситуации сначала убедитесь, что уже корректно названы все инструменты, используемые по всей 
партитуре, чтобы они легко идентифицировались: дважды щелкните по области слева от любого 
нотоносца и затем пройдите по списку инструментов в диалоговом окне, которое появляется, 
переименовывая любой при необходимости, посредством выбора его и щелчка по Rename… 

{Переименовать…}. 
Затем пройдите по каждому некорректно определенному нотоносцу в окне вывода (сверху донизу), 
щелкая правой кнопкой по существующему названию инструмента слева от рассматриваемого 
нотоносца и выбирая корректный инструмент из меню, которое появляется. Если вы неспособны выбрать 
конкретный инструмент, то это, вероятно, потому что упорядочивание инструментов не корректно, и 



должно быть изменено путем следования инструкциям в разделе Инструменты/нотоносцы, 

представленные не с самого начала (ниже). 
В любой системе, в которой есть пропущенные нотоносцы, вам придется, вероятно, исправить несколько 
названий инструментов именно таким способом. Действуйте аккуратно, иначе вы только увеличите путаницу. 

Инструменты, занимающие несколько нотоносцев 
Для инструментов, имеющих множество нотоносцев (как клавишные или струнные дивизи, духовые дивизи), 
программа PhotoScore обрабатывает каждый нотоносец как инструмент со своим названием. Если количество 
нотоносцев для сложного инструмента меняется во всем исходном материале, например, если струнные дивизи, 
чтобы избежать конфликтов, лучше всего задать нотоносцам совершенно разные названия, например, Viola a и 
Viola b. (После отправки материала в программу Sibelius вы всегда сможете исправить названия на нужные.) В 
каком бы случае ни были пропущены инструменты, следуйте правилам Пропускаемые нотоносцы (см. выше). 
Примечание. Если количество нотоносцев для инструмента в партитуре увеличивается (скажем, с 1 до 2) и 
второй нотоносец до этого не появлялся, обработайте его по правилам Инструменты или нотоносцы, 

представленные не с самого начала (см. ниже). 

Инструменты/нотоносцы, представленные не с самого начала 
В некоторых партитурах бывают инструменты или нотоносцы, которые не показаны на начальной системе. В 
таких случаях (когда инструмент или нотоносец появляется позже) нужно выполнить следующее: 

 Во-первых, убедитесь, что PhotoScore знает о существовании всех нотоносцев для всех инструментов 
(PhotoScore трактует нотоносцы для инструментов, занимающих несколько нотоносцев, отдельно): 
Дважды щелкните по области слева от любого нотоносца так, чтобы появилось диалоговое окно. Затем 
убедитесь, что название каждого инструмента корректно – если его надо изменить, выберите его и нажмите 
Rename…{Переименовать}. Если перечисленных инструментов недостаточно, нажмите New... {Новый…} 

для добавления новых. Убедитесь, что они перечислены в порядке, в котором они появились бы, если бы были 
все записаны в одной системе: Для переупорядочения, выберите инструмент и используйте желтые стрелки 
вверх и вниз слева от списка (они работают таким же образом, как и в диалоговом окне Scanned pages 

{Сканируемые страницы} – см. выше). Можно удалить из списка любые инструменты, которые не были 
распределены, щелкнув по Delete. Нажмите Close {Закрыть}, когда вы закончите. 

 Затем пройдите по каждому нотоносцу в окне вывода (сверху донизу), щелкая правой кнопкой слева от 
него и выбирая соответствующее название инструмента из меню. Если вы неспособны выбрать конкретный 
инструмент, то это, вероятно, потому что упорядочивание инструментов не корректно, и должно быть изменено с 
помощью инструкций в предыдущем абзаце. 
Делать все это нужно очень аккуратно, чтобы не внести еще большей путаницы. 

Чтение фразировочных лиг / вилок (не Облегченная версия) / связующих лиг 
Для переключения распознавания легато/лиг/вилок, откройте диалоговое окно Установок PhotoScore и щелкните 
на Reading {Чтение}. Нажмите Ties, Slurs and Hairpins {Легато, лиги и вилки}, чтобы выбрать/отменить 
выбор, и затем нажмите "OK". Если Display these options before reading {Показывать эти параметры 

перед чтением} выбрано в Установках, вам будет дана возможность обновить предпочтения чтения в начале 
каждого считывания. 

Чтение аподжатур и нот мелкого раштра (не Облегченная версия) 

 Распознавание аподжатур (также известны как форшлаги) и нот мелкого раштра может быть переключено 
вкл/выкл из диалогового окна Установок PhotoScore; что касается фразировочных лиг / вилок / связующих лиг – 
см. выше. 
Если вы обнаружили, что PhotoScore распознала ноту мелкого раштра как аподжатуру (или наоборот), то вы 
можете исправить это с ‘ клавиатуры’ – см. главу 3. РЕДАКТИРОВАНИЕ. Вы можете обычно проверить на эти 
ошибки посредством поиска тактов, содержащих ошибки ритма (помеченные горизонтальными красными 
пунктирными линиями выше и ниже такта). 
Напоминание: длительность аподжатуры не включена в ритм такта, тогда как длительность ноты мелкого раштра 
включена. Обе выглядят похоже, записанные как ноты меньшего размера, но вы можете указать различие с 
‘клавиатуры’. 

Чтение текста (не Облегченная версия) 

Чтение текста может быть переключено вкл/выкл из диалогового окна Установок PhotoScore, что касается 
вышеупомянутых опций. 
Кроме того, кнопка Advanced… {Дополнительно…} позволяет вам выбрать, какие типы текстов PhotoScore 
попытается считать, а также какой язык должен быть распознан. Выбранный язык изменяет способ, которым 
PhotoScore считывает текст, следующим образом: 



 Названия инструментов ожидаются на этом языке, и будут распознаны более точно, если они имеются. 

 Дополнительные языково-зависимые символы будут распознаны более вероятно (такие как ä, é, ò и т.д.) 

 PhotoScore ищет специфичные для языка функции слов, для улучшения точности. 
Больше языков доступно для скачивания из Интернета посредством щелчка на Больше онлайн … 

(www.neuratron.com/idrslanguages.htm). 
300 точек на дюйм являются оптимальным разрешением для распознавания текста. 
Пользователи Sibelius  
При чтении текста, PhotoScore автоматически предполагает его тип (например, заголовок, текст песни, техника). 
Когда музыка отправлена в Sibelius, каждый текстовый объект получает стандартный шрифт и размер для его 
типа. 

Режим Исполнения 
Режим Исполнения может быть выбран из панели инструментов окна вывода, из пункта меню View> 

Performance Mode {Вид> Режим Исполнения}, или путем ввода Ctrl+M. 
В режиме Исполнения выходная партитура выводится на полный экран и отформатирована так, чтобы ее было 
легко читать с маленького расстояния. Страницы разделены в разумных позициях, где необходимо, и 
использование клавиш управления курсором позволяет вам переключаться на различные страницы или разделы 
страниц. Можно альтернативно использовать управляемые ногой устройства переворачивания страниц, 
наподобие Bili Footime Page Turner. Это позволяет вам исполнять с монитора вашего компьютера и быстро и 
легко менять страницу с помощью ноги, пока вы играете. 
Режим Исполнения может быть выключен посредством щелчка мыши или нажатия Escape или Ctrl+M. 

 
 

Установки (Настройки) PhotoScore 
Диалоговое окно Установки PhotoScore {Preferences} может быть открыто с панели инструментов или меню 
File {Файл}. Установки разделены на четыре категории - Сканирование, Чтение, Правка/Редактирование и 
Дополнительно. Можно выбрать различные категории с помощью щелчка по соответствующему заголовку 
диалогового окна, в его верхней части. 
Сканирование – интерфейс {Scanning - Interface} 

См. главу 1. Сканирование  для объяснения трех интерфейсов сканирования. 
Сканирование – Автоматизация {Scanning - Automation} 

 Создать уровень сканирования {Make scans level}: Если этот параметр включен, программа 
PhotoScore будет определять, как повернут скан, и затем повернет его так, чтобы нотоносцы находились на 
одном уровне. Рекомендуется оставить этот параметр включенным. 

 Читать сразу после обработки {Read pages after scanning/opening}: Если этот параметр включен, 
PhotoScore автоматически начнет распознавать страницы после того, как они будут отсканированы или открыты 
из файлов. 
Чтение - рукописная / печатная {Reading - Handwritten / Printed} 

 Читать как рукописную музыку {Read as handwritten music}: Когда выбрано, PhotoScore в состоянии 
считывать рукописную музыку. Очень важно, чтобы это было включено при сканировании рукописной музыки 
(Только Полная версия) и выключено, когда сканируется печатная музыка, иначе, точность значительно 
пострадает. 
Чтение - Что требуется читать {Reading - What to read} 

 Легато, лиги (и Вилки в печатной нотации) {Ties, Slurs (and Hairpins if printed music)}: См. Чтение 
фразировочных лиг/вилок/связующих лиг (выше). 

 Метки артикуляции {Articulation marks} (не Облегченная версия, только печатная музыка): Это особо 
не замедляет считывание, так что мы предлагаем, чтобы вы оставили это включенным. 

 Форшлаги, ноты мелкого раштра {Appoggiaturas and cue notes} (не Облегченная версия, только 
печатная музыка): Если эти ноты меньшего размера нечасто берутся неправильно, или вы не против, чтобы 
PhotoScore читал чуть менее быстро, то мы предлагаем вам оставить опцию включенной. Также см. Чтение 
аподжатур и нот мелкого раштра (выше). 

 Схемы аккордов гитары {Guitar chord diagrams} (не Облегченная версия, только печатная музыка): 
Это особо не замедляет чтение, так что мы предлагаем вам оставить опцию включенной. 

 Текст (динамика, стихи и т.д.) {Text (dynamics, lyrics etc.)} (не Облегченная версия, только 
печатная музыка): См. Чтение текста (выше). 

 Туплеты (доп. определение ритма) {Tuplets (includes advanced rhythm detection)}: При включении этой  



опции распознаются/вычисляются туплеты/триоли (Облегченная версия - только простые триоли). Эта опция 
также влечет попытку PhotoScore исправить любые музыкальные ошибки после считывания (не Облегченная 
версия): Если обозначение метрического размера отсутствует, программа попытается предположить, каков он. 
Если успешно, то она вставляет метрический размер в начале страницы; он будет окрашен красным, как 
предупреждение для вас проверить его. Кроме того, PhotoScore анализирует музыку, которую она считала, и 
пытается исправить любые ошибки ритма с помощью общих музыкальных правил. Хотя это будет обычно 
увеличивать точность, но при сканировании партитур с необычным «метром» опцию, может быть, лучше 
отключить. 

 Транспонируемые партитуры {Transposing scores} (не Облегченная версия): С этой включенной 
опцией PhotoScore в состоянии считывать транспонирующие инструменты с различными ключевыми знаками для 
каждого нотоносца, иначе они все устанавливаются одинаковыми. 
Правка – форматирование {Editing - Formatting} 

 Автоматически обозначать поля страниц {Automatic page margins}: Это гарантирует, что разумные 
поля всегда присутствуют вокруг каждой страницы партитуры, чтобы это выглядело привлекательным в 
распечатанном виде. 
Правка - Окно вывода {Editing - Output window} 

 Панель просмотра привязать к текущему нотоносцу {Attach scanned staff panel to current staff}: В 
окне вывода при включенном параметре исходный сканируемый нотоносец отображается чуть выше 
выделенного нотоносца (а не в верхней части окна, как обычно). Это означает, что вам меньше надо перемещать 
глаза при сравнении вывода с оригиналом, но эффект может сбить с толку. Мы рекомендуем оставить эту опцию 
выключенной, пока вы не привыкли редактировать музыку в PhotoScore. 

 Перетаскивание листа {Drag paper by}: Это может быть установлено или в Простое 

перетаскивание {Dragging} или Перетаскивать, удерживая Shift {Holding Shift and Dragging}. Если выбрано 

первое, то лист будет перемещаться в технике ’нажать-и-перетащить’ только мышью, а выбор области музыки 
делаться путем перетаскивания мышью, но с удерживаемой клавишей Shift. Если выбрана последняя опция, 
тогда эти операции выполняются наоборот. 

 Макет клавиатуры {Keypad layout}: Выберите или стандарт макета клавиатуры Sibelius, или 'плоскую' 
версию PhotoScore, предлагающую все кнопки сразу. 
Дополнительно – воспроизведение {Advanced - Playback} 

 Можно выбрать устройство воспроизведения MIDI, используемое программой PhotoScore для 

воспроизведения, из выпадающей рамки. 
 Системные настройки воспроизведения … {System playback properties}: Нажатие здесь открывает 
диалоговое окно управления звуком вашего компьютера, позволяя выбрать устройства для записи и 
воспроизведения звука и предпочитаемое устройство воспроизведения для MIDI. 

 Игнорировать повторы и мультипаузы {Ignore repeats and multirests}: Если это будет помечено, 
программа PhotoScore проигнорирует все знаки повторения в партитуре во время воспроизведения. 

 Проигрывать всю систему нот полностью {Always play whole system}: Снимите флажок с этой опции, 
если вы хотите, чтобы программа PhotoScore воспроизводила только те инструменты, нотоносцы которых 
содержат нотацию, которую вы выбрали. Воспроизведение запустится с начала первого такта, который содержит 
выбор. 
Дополнительно – Прочие настройки {Advanced - Miscellaneous} 

 Показывать заставку при запуске {Display splash screen at startup}: Когда включено, экран приветствия 
программы PhotoScore выводится на экран при ее запуске. 

 Автосохранение каждые _ мин. {Auto-save backup file every _ minutes}: Здесь возможно определить 
временной интервал, через который PhotoScore сохраняет вашу текущую партитуру в специальном 'резервном' 
файле. В неприятном случае, когда ваш компьютер отказывает, PhotoScore предложит вам возможность 
открытия этого файла в следующий раз, когда она запускается, чтобы свести к минимуму любые потери.   
Если вы измените какую-либо из этих опций и нажмете "OK", они останутся в новых настройках, пока вы не 
измените их снова. Щелчок по Cancel возвращает их к исходным настройкам, когда диалоговое окно было 
открыто. 

 

 

 



 КЛАВИШИ БЫСТРОГО ВЫЗОВА 
Ctrl+A Выбрать все объекты 
Ctrl+C Копировать объект в буфер обмена 
Ctrl+F Найти и заменить 
Ctrl+X Вырезать объект в буфер обмена 
Ctrl+V Вставить объект из буфера обмена 
Ctrl+Z Отмена последнего действия редактирования 
Ctrl+Y Восстановление последнего отмененного действия редактирования 

Shift+F7 Вывести на экран макет Клавиатуры Основные ноты / F7 вызывает Справку по NotateMe/ 
F8 или Shift+F8 Вывести на экран макет Клавиатуры Другие ноты 
F9 или Shift+F9 Вывести на экран макет Клавиатуры Лучи 
F10 или Shift+F10 Вывести на экран макет Клавиатуры Знаки артикуляции 
F11 или Shift+F11 Вывести на экран макет Клавиатуры Знаки альтерации 
Tab Выбрать следующий объект 
Shift+Tab Выбрать предыдущий объект 
Стрелка курсора влево/вправо  Выбрать предыдущий/следующий объект 
Ctrl+влево/вправо Выбрать первый объект в предыдущем/следующем такте 
Shift+курсор влево/вправо Расширить выбор на предыдущий/следующий объект 
Ctrl+Shift+ курсор влево/вправо Расширить выбор до предыдущей/следующей тактовой черты 
Delete или Backspace Удалить  выбранный объект(ы) 
Ctrl+NUM+ Увеличить масштаб отображения 
Ctrl+NUM- Уменьшить масштаб отображения 
Q Показать меню ключей 
K Показать меню ключевых знаков (тональности) 
L Показать меню линий 
T Высветить диалоговое окно обозначения метрического размера 
Z Показать меню символов (Сэньо, педаль,…) 
Alt+B  Высветить диалоговое окно мульти-пауз 
Alt+F4 Выход из программы 
H  Создать крещендо 
Shift+H Создать диминуэндо 
S  Создать фразировочную лигу (выше нотоносца) 
Shift+S  Создать фразировочную лигу (ниже нотоносца) 
Shift+T Транспозиция 
Ctrl+Alt+T Создать текст темпа 
Ctrl+Shift+T  Включить/выключить Навигатор неверного счета (ошибок ритма) 
Ctrl+Shift+R  Поместить перечитываемую страницу в конец партитуры 
Ctrl+T  Включить/выключить индикацию тактов с ошибками ритма 
Ctrl+N  Включить/выключить цвета голосов 
Ctrl+H  Включить/выключить затенение нотного текста 
Ctrl+M  Включить/выключить Режим Исполнения (полноэкранный) 
Ctrl+I  Показать/скрыть паузы 
Alt+B  Создать тактовую мульти-паузу 
Ctrl+L Создать текст стихов песни 
Ctrl+B Создать тактовую паузу 
Ctrl+E Включить/выключить Панель страниц 
Shift+K Создать схему аккорда 
Ctrl+K Создать обозначение аккорда 
Ctrl+2…9 Создать туплет введенного числа 
2…9 Нормальный нотоносец: Более высокий интервал для добавления к ноте 
Shift+2…9 Нормальный нотоносец: Более низкий интервал для добавления к ноте 
0…9 Нотоносец табулатуры: Номер Лада выбранной ноты 
X Перевернуть штиль выбранной ноты 
Курсор вверх/вниз Нормальный нотоносец: Переместить ноту вверх/вниз 

Нотоносец табулатуры: Выбрать ноту выше/ниже в аккорде 
Alt+курсор вверх/вниз Выбрать ноту выше/ниже в аккорде 
Ctrl+Shift+курсор вверх/вниз Перепрыгнуть на нотоносец выше/ниже (для нот-перебежчиков) 
P  Играть/приостановить Партитуру 
Пробел Играть/приостановить Партитуру 

Escape Отменить выбор всех 

F1 Вызов Справки по PhotoScore (англ.) 
F2  Вызов Советов по сканированию (англ.) 



F3  Вызов Справки по PhotoScore (рус.) 
F4  Вызов Советов по сканированию (рус.) 
F5  Вызов Справки по PhotoScore (нем.) 
F6  Вызов Советов по сканированию (нем.) 
F7  Вызов Справки по NotateMe (англ.) 
Ctrl+O Открыть файл 
Ctrl+P Печатать файл 
Ctrl+S Сохранить файл 
Ctrl+W Сканировать страницы 
Ctrl+D Отправить в Sibelius /пока не работает для ‘демо’-версии/ 
Ctrl+G Отправить в нотный редактор G7 (гитарный) 
Ctrl+, Установки PhotoScore 

 

 

 

 ГЛОССАРИЙ 
Здесь объясняются музыкальные и компьютерные термины, использованные в этом руководстве, которые не 
являются распространенными. 
BMP (.bmp) Стандартный растровый графический файл Windows. 
TIFF (.tif) Форматы файлов, сохраняемые PhotoScore (Полная версия) и другими программами сканирования, 
которые содержат основные данные отсканированного изображения. Эти файлы не содержат музыкальной 
информации как таковой, только сетка черных и белых точек, которые составляют изображение. 
dpi (dots per inch) точек на дюйм - единица разрешения при сканировании. Чем больше точек на дюйм, в которых 
вы сканируете, тем выше разрешение, и более подробный получающийся скан. 
От 200 dpi до 400 dpi -  н ормальный диапазон разрешений для сканирования музыки; более высокие 
разрешения, такие как 600 dpi, часто используются для сканирования фотографий и графики. 
Grayscale (Полутоновые) Оттенки серого. 
MIDI стандарт, специально предназначенный для коммуникации и хранения данных, которые музыкальный 
секвенсер записывает и играет. Также формат файла (.mid), сохраняемый PhotoScore, который может быть 
открыт большинством музыкальных программ. 
MusicXML (.xml) формат файла для переноса музыкальной нотации между различными программами. Это 
рекомендованный способ перемещения музыки между нотными редакторами Finale и Sibelius 

NIFF (.nif) Форматы файлов, сохраняемые PhotoScore (Полная версия), которые могут быть открыты 
 различными программами музыкальной нотации. См. www.neuratron.com/fileformats.htm. 
OCR Оптическое распознавание символов; обычно применяется к сканированию текста, но также и к музыке. 
Original (Исходная) страница или партитура, которую вы сканируете. 
Выход/вывод Музыка, которая была считана из сканов. 
Чтение-распознавание  процесс решения, каковы все ноты и другие символы на скане.  
Разрешение уровень детализации, в котором отсканирована страница; измеренный в точках на дюйм.  
Скан Изображение, получаемое, когда страница была отсканирована. В PhotoScore, сканы всегда 
выводятся на экран с фоном цвета буйволовой кожи. 
Отсканированная музыка (SCMS/.opt) специальный формат музыкального файла, разработанный Neuratron, 
чтобы сохранить распознанные музыкальные страницы и облегчить передачу такой музыки музыкальным 
программам нотации, таким как Sibelius. 
Драйвер сканера программа, которая говорит компьютеру, какой у вас тип сканера; аналогично драйверу 
принтера. Они обычно соответствуют одному из двух стандартов - TWAIN или WIA. 
SCSI (произносится ‘скази’) стандарт для подсоединения сканеров, жестких дисков и других устройств к 
компьютерам. Требует платы SCSI и кабеля SCSI (которые походят на карту MIDI и кабель MIDI). 
TWAIN 'переводчик' между сканерами и программным обеспечением сканирования. 
USB стандарт для подсоединения сканеров, мышей, веб-камер и других устройств к компьютерам. Требует 
USB-порт и USB-кабель (которые походят на карту? MIDI и кабель MIDI). 

Волновый формат (.wav) формат файла-контейнера для хранения записи оцифрованного аудиопотока. 
WIA 'переводчик'  между сканерами и программным обеспечением сканирования. 
Вольта  окончание повтора. 
Знак альтерации символ (например, диез, бемоль), обозначающий, что высота звука должна быть на небольшой 



интервал выше или ниже – обычно на полтона, но иногда бывает и на целый тон. 
Знак артикуляции символ, появляющийся над или под нотой или аккордом, который обозначает, как они должны 
быть исполнены – например, стаккато, тенуто, акцент, фермата (пауза). 
Реверберация  эффект искусственного эха 
Табулатура гитарная табулатура  нотация, где линии нотоносца представляют гитарные струны, а номера ладов указывают 
положение пальцев. 
Транспонирующий инструмент  инструмент, для которого нотация пишется в одной тональности, но звучит он в 
другой, например, кларнет. 
Транспонируемая партитура партитура, в которой музыка транспонирующих инструментов не записана так, 
как она звучит на самом деле. 
Штиль  вертикальная линия у нот или аккордов, иногда неверно называемая «хвостиком». 
Хвостик   загнутый флажок одной восьмой ноты или более короткой по длительности звучания ноты. 
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Приложение. Макеты виртуальной клавиатуры PhotoScore 8 

 

 

Клавиатура горизонтальная  (Макет PhotoScore – Единственная панель): 

 

Очистить 

инструменты
Акцент Стаккато Тенуто Фермата (пауза)

Приглушение/ 

закрыт. хай-хет

Движ.смычка 

вверх

Движ.смычка 

вниз
Маркато Стаккатиссимо

Обертон/откры-

тый хай-хет

Удалить 

артикуляцию

Бекар Диез Бемоль Дубль-диез Дубль-бемоль
Натуральный 

диез

Натуральный 

бемоль
Бревис Тактовая пауза

Целая нота Половинная Четвертная Восьмая 16-я 32-я 64-я 128-я
Ритмическая 

точка
Двойная точка Тройная точка Лига

Пауза Без луча Начало луча Середина луча
Перевернуть 

штиль
Форшлаг

Мелкие ноты 

вкл/выкл

Нотная головка-

крест
            Голоса 1 - 2 - 3 - 4

 



Клавиатуры вертикальные,  макет Sibelius  (на пяти страницах) 

Очистить инструменты Акцент Стаккато Тенуто

Бекар Диез Бемоль 1-я раскладка кл.

Четвертная Половинная Целая След.стр-ца кл.

32-я 16-я 8-я

Ритм.точка

Голоса 1-2-3-4

Лига
Пауза

 

 Клавиатура 1 – Основные ноты (Shift+F7) 

 

Очистить инструменты Форшлаг Нотн.головка - крест

Бревис 1-я раскладка кл.

64-я 128-я След.стр-ца кл.

Ритмическая точка Двойная точка Тройная точка

Голоса 1-2-3-4

Мелкие ноты вкл/выкл
Тактовая пауза

 

 Клавиатура 2 – Другие ноты (F8) 

 

Очистить инструменты Без луча

Начало луча Середина луча 1-я раскладка кл.

След.стр-ца кл.

Перевернуть штиль

Голоса 1-2-3-4  

 Клавиатура 3 – Лучи (F9) 

 

Очистить инструменты Акцент Стаккато Тенуто

 Маркато Стаккатиссимо 1-я раскладка кл.

Приглуш./закрытый хай-хет Движ.смычка вверх Движ.смычка вниз След.стр-ца кл.

Фермата (пауза)

Обертон/открытый хай-хет

Голоса 1-2-3-4

Удалить артикуляцию

 

 Клавиатура 4 – Артикуляция (F10) 

 

Очистить инструменты Дубль-диез Дубль-бемоль

Бекар Диез Бемоль 1-я раскладка кл.

Натуральный диез След.стр-ца кл.

Натуральный бемоль

Голоса 1-2-3-4

Удалить знаки альтерации

 

 Клавиатура 5 – Знаки альтерации (F11) 


